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Preface

This redbook will help you install, tailor and configure Universal Manageability
(UM) Services to help manage your server and workstation environment. In
addition to showing how to install and configure UM Services, this book walks you
through the steps that are necessary to provide the integration to systems
management frameworks. The frameworks that UM Services integrates with are
Tivoli, SMS (both V1.2 and V2.0), CA Unicenter and Intel LANDesk.

This book can be used by systems integrators to help establish the framework for
systems management. In addition, anyone building a new environment from
scratch will greatly benefit from the step-by-step approach that is shown in the
installation chapter.

The Team That Wrote This Redbook

This redbook was produced by a team of specialists from around the world
working at the International Technical Support Organization, Raleigh Center.

Barry Nusbaum is a Consulting support representative at the International
Technical Support Organization, Raleigh Center. He writes extensively and
teaches IBM classes worldwide on all areas of systems management on the NT
and AIX platform. He is also currently working on projects related to the
e-business Application Framework and WebSphere. Before joining the ITSO
seven years ago, he worked in Professional Services in the United States as a
National Communications Specialist. You can reach him by e-mail at
bnusbaum@us.ibm.com.

Cesar Augusto Coelho Ripari is a Technical Solution Architect for IBM clients at
IBM Brazil. He has eight years of experience in PC technical support and
systems development. He holds a degree in Computer Science and has taken an
extension course in Business Administration. His areas of expertise include
networking, PC hardware and operating systems, such as Windows NT and
Windows 95. Currently he is providing solutions for network stations and servers
management.

Thanks to the following people for their invaluable contributions to this project:

Julianne Bielski, Xiao Huang, Eric C. Rasmussen, Goran Wibran
IBM RTP Development

Comments Welcome

Your comments are important to us!

We want our redbooks to be as helpful as possible. Please send us your
comments about this or other redbooks in one of the following ways:

• Fax the evaluation form found in “ITSO Redbook Evaluation” on page 189 to
the fax number shown on the form.

• Use the online evaluation form found at http://www.redbooks.ibm.com/

• Send your comments in an Internet note to redbook@us.ibm.com
© Copyright IBM Corp. 1999 v
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Chapter 1. Universal Management Services

What is Universal Management (UM) Services? It is a set of services, based on
the Windows Management Information specification, that provides systems
management information on IBM ThinkPads, workstations and Netfinity Servers.
UM Services works best on IBM hardware, but it runs on other OEM systems that
support SMBIOS V2.0. The information provided by UM Services can be viewed
from a Web browser (such as Internet Explorer or Netscape Navigator), a
Microsoft Management Console (MMC) snap-in, or an upward integration module
installed on top of an enterprise or workgroup management product.

This redbook describes how to install and use the features of UM Services, as
well as its integration with other enterprise management products, such as
LANDesk Management Suite, Tivoli Enterprise, Microsoft SMS and CA Unicenter
TNG.

One of the ways that UM Services is able to interface with so many systems is
that it takes advantage of industry standards (DMI, SNMP and CIM) to interact
with these subsystems.

1.1 Environment

It did not take a complex environment to show how to access the UM Services
functions and the data it captured. The actual functions and data are somewhat
independent of the hardware. While there is a specific list of hardware that is
supported, the methodology used remains the same.

We used Netfinity 3000 Servers and IBM PC 300 PL workstations as our main
systems to show all the functions. For an operating system environment we used
Windows NT with Service Pack 4 (and in some cases with Option Pack installed).
© Copyright IBM Corp. 1999 1
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Chapter 2. UM Services Installation and Operation

The UM Services installation code can be downloaded for free from
http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products.html.

Figure 1. UM Services Free Downloads

Figure 2. Download Options
© Copyright IBM Corp. 1999 3



2.1 Installation

The installation structure for the Universal Manageability Services (UM Services)
and the Plus module is quite simple.

Figure 3. Unzipped Installation Directory

Before installing UM Services you should read this book as well as the PDF that
is distributed with the product. To install UM Services you should click the setup
program setup.exe. It is a typical InstallShield-type installation process.

Figure 4. InstallShield Wizard

After the InstallShield Wizard sets up its environment you can page through the
welcome, language and license agreement screens by clicking Next. When you
get to the setup options you need to determine if this installation is a stand-alone
UM Services install or if it’s being installed on a system that has a supported
upward integration management module (Tivoli NetView, CA Unicenter and
SMS). The following install process is for the stand-alone version. The
Workgroup/Enterprise integration installations are shown in separate chapters.
4 Universal Manageability: Enterprise Management Integration



Figure 5. Management Integration or Services

We clicked the first option to install UM Services. That presented us with the
following installation options:

Figure 6. UM Services Components

Since we did not have Intel LANDesk installed on this system we left that box
unchecked. If we had it installed, checking that box would install LANDesk’s
Common Base Agent (CBA). If a user already has the CBA installed on the
system, then he or she should not check this box.

In addition, the Tivoli Management Agent should only be checked in an
environment where the use has deployed the Tivoli Enterprise product. The
default is for it not to be checked and installed.

If you select Web Based Remote Control you should respond No to the prompt for
Netfinity Director’s remote control program since you should not have them both
on the same system.
Chapter 2. UM Services Installation and Operation 5



Since the system detected that we had SNMP already installed it selected that
option for us.

After you select your options you are given the opportunity to select the directory
in which the services code will be installed. Following that you are prompted for a
user ID and password for Web access. Be sure to check with your systems
administrator so that you don’t give away higher authorizations than necessary. In
this case, our systems administrator and our Web administrator were the same
person so we used the administrator user ID.

You can leave the default port (411) as the one that you will use to access the UM
Services data. If you change it you will need to remember the new port number
when you access the system using a Web browser or the Microsoft Management
Console (MMC). We recommend that you stick with the default port and use the
same port for each system so it is easier for your administrators. If you do change
the port after installation has occurred be sure to notify everyone who accesses
the systems.

If you forget which port you chose you can look in \winnt\umsclients.ini:

Figure 7. Web User ID

Click Next and the next window asks you if you want to update your start menu.
To add it click Yes. In some environments it is not desirable to have this on the
start menu. You should probably specify no on all systems other than
administrator systems.

[HTTP Port]
barryps2=411
6 Universal Manageability: Enterprise Management Integration



Figure 8. Updates to the Start Menu

In addition to installing the code options that we mentioned, interfaces for
components like WBEM and Tivoli are automatically provided.

Figure 9. Component Installation

Shortly after that you are prompted to reboot your system. Before doing that you
might want to take a look at some of the log files that are created. For example, in
c:\winnt\system32 the file twginst.log is created to show the Netfinity Director
agent installation results:

There is another log file that is interesting that is in
c:\winnt\system32\WBEM\Instcore.log. A piece of its contents follows:

6-23-1999 11:18:29 -- ==========================================
6-23-1999 11:18:29 -- Install of Tivoli IT Director Agent started
6-23-1999 11:18:29 -- Installing from C:\TEMP\_ISTMP5.DIR\NFD\EN\
6-23-1999 11:18:29 -- ...Unattended Install in progress...
6-23-1999 11:18:29 -- TwgCheckISRequirements returned 0
6-23-1999 11:18:29 -- TwgInitializeIS returned 0
6-23-1999 11:18:29 -- Exe = NET; Parm = STOP TWGIPC; Launchr = 1
6-23-1999 11:18:30 -- Program returned 2
6-23-1999 11:18:30 -- Uncompressed the verification routines.
6-23-1999 11:18:30 -- TwgGetTemporaryFiles returned 0
6-23-1999 11:18:30 -- Installing version 210090615
6-23-1999 11:18:30 -- TwgWelcomeDlg returned 0
6-23-1999 11:18:30 -- TwgLicenseDlg returned 1
6-23-1999 11:18:30 -- User specified TargetDrive: D
6-23-1999 11:18:30 -- User specified Target Directory: \Program Files\IBM\UMS\Di
rector
6-23-1999 11:18:30 -- TwgUninstSpace returned 0
Chapter 2. UM Services Installation and Operation 7



You should also look through the odbc.ini and odbcinst.ini files as well.

Figure 10. Restart Your System

2.1.1 Launching the UM Services Browser
One way to launch the UM Services browser is from the start menu as shown in
the following figure:

Figure 11. Start Menu Used to Launch the Browser

After you click on the start option you have to enter the correct user ID and
password to access UM Services. Note that the port number is the same as the
one you chose during the installation phase (411).

Title:
Source: E:\ROADRU~1\RR\wbemcore.exe
Execute Path: C:\WINNT\System32\WBEM\wbemstop.exe
Execute Path: C:\WINNT\System32\WBEM\WinMgmt.exe /unregserver
Execute Path: C:\WINNT\System32\WBEM\unsecapp.exe /unregserver
***Start WBEM Core***
Made Dir: C:\WINNT\System32\WBEM
File Copy: C:\WINNT\System32\WBEM\cimwin32.dll
File Copy: C:\WINNT\System32\WBEM\cimw32ex.dll
File Copy: C:\WINNT\System32\WBEM\fastprox.dll
File Copy: C:\WINNT\System32\WBEM\framedyn.dll
File Copy: C:\WINNT\System32\WBEM\stdprov.dll
File Copy: C:\WINNT\System32\WBEM\wbemcore.dll
File Copy: C:\WINNT\System32\WBEM\wbemess.dll
File Copy: C:\WINNT\System32\WBEM\wbemprox.dll
File Copy: C:\WINNT\System32\WBEM\wbemcomn.dll
File Copy: C:\WINNT\System32\WBEM\WinMgmtR.dll
8 Universal Manageability: Enterprise Management Integration



Figure 12. UM Services User ID

In our case we used the administrator ID. Our Web browser was Microsoft
Internet Explorer V5.0. In addition to responding to the user ID and password
there were several prompts to verify the scripts that were running. These scripts
are used to build the interface. The reason that we were prompted for this was
that we had a high security setting in place on our Internet Explorer.

Figure 13. Certificate Authentication

After responding Yes to several prompts the full UM Services window appeared:
Chapter 2. UM Services Installation and Operation 9



Figure 14. UM Services Using Internet Explorer V5.0

After verifying that we could access the data with Internet Explorer V5.0 we
proceeded to try Netscape. Before the Netscape browser could successfully
access the data there were some Java-type modifications that needed to take
place as shown in the following window:

Figure 15. UM Services Java Libraries Required

Just download the two files and run them. They will automatically install. The only
trick is if you are using Netscape as your default browser you should make sure
10 Universal Manageability: Enterprise Management Integration



that you access UM Services with Netscape first to install the Java libraries. You
can then shut down Netscape and make IE your default browser. Then start it up
and install the Java libraries in the same manner. The two files that you download
are called swingall.exe and xml4j.exe.

A third way to access UM Services is by using the Microsoft Management
Console (MMC). When you install the MMC interface you get a prompt to
acknowledge the license agreement. If you install the MMC as part of the
Windows NT Option Pack you won’t have to install it separately.

2.1.2 Accessing the Data
Once we installed the Java updates we were able to use Netscape to access our
UM Services data. Netscape V4.5 is the minimum requirement and we used that
plus Netscape V4.6, V4.6.1 and V4.7 on the Windows NT platform.

Figure 16. Main UM Services Wwindow on Netscape

In the left-hand pane of the window there are two lists of functions that are
available to use. There is an Information list and a Tasks list.
Chapter 2. UM Services Installation and Operation 11



Figure 17. UM Services Information and Tasks for a Netfinity 3000

2.1.2.1 Tasks
If your hardware supports Alert on LAN (AOL) you can set up the configuration
from a Web browser or from MMC. With the click of a button or two you can
quickly (and remotely) perform the configuration. Just update the fields and click
Apply.

Note: The initial release of UM Services did not support Alert on LAN, but as of
November 1999 that support was provided.

Figure 18. Alert on LAN

There is some hardware information that is automatically gathered for you for the
systems that have the UM Services installed. Some of the tabs are informational
and some of them have fields that you can update. For example, you can click the
User tab and add the user’s phone number.
12 Universal Manageability: Enterprise Management Integration



Figure 19. Asset Information

You can change the date or time of any system that has the UM Services code
installed. That is useful when the clocks change or if you need to do some testing
with a scheduling function.

Figure 20. Change the Date or Time

The Network task has TCP/IP binding information for the adapters that are in the
machine. This information is read-only.
Chapter 2. UM Services Installation and Operation 13



Figure 21. TCP/IP Bindings

The SNMP information (assuming you had already installed SNMP on the
system) has the community name and the destination addresses for traps. The
updates to this window are the same as the updates you can perform locally.

The User Security item provides you with access to the Windows User Manager
functions. By default, it only sees the administrator ID. You can add or remove IDs
using this function.

The User Security service provides four levels of access:

1. Administrator
2. Browser
3. Power User
4. User

An administrator can get or set data from every service and add users. Everyone
else can browse but not change settings or save data.

Figure 22. User Administration

In the Tools section of the Tasks list you might just see the Remote Control and
Shutdown tools. If you don’t see the DMI Information link than it indicates that you
14 Universal Manageability: Enterprise Management Integration



have not started the DMI-related service (win32sl). Go into the Services function
and start it or issue the start win32sl command from the DOS prompt.

Figure 23. Start DMI

You should see the DMI Information task appear if you refresh or restart your Web
browser.

Figure 24. DMI Task Added

A sample of some of the information you can access is shown below:
Chapter 2. UM Services Installation and Operation 15



Figure 25. DMI Information

UM Services does not provide any DMI instrumentation. It is there for backward
compatability only. Certain UM desktop extensions use DMI instrumentation and
in those cases, the browser will show more than just information about the
service layer.

You can set up the remote control monitoring functions using the Web browser.
The options you can choose are shown in the following figure:

Figure 26. Remote Control

When you click the Start session button access to the UM Services begins.

On the service you see the following window:
16 Universal Manageability: Enterprise Management Integration



Figure 27. Remote Control

On the system that has your Web browser that issued the start session you see
the following window:

Figure 28. Tivoli Remote Control Session

You can also shut down the UM Services system or log off the current user by
clicking the Shutdown task.
Chapter 2. UM Services Installation and Operation 17



Figure 29. System Shut Down

The last task that we used was the one for System Updates. That task will launch
a new Web browser window and automatically take you to the IBM Web pages
that show you what updates are available for the hardware configuration on which
you have installed UM Services.

Figure 30. System Updates

If you click Drivers you can see what information is available. You can download
new drivers, read FAQs, get information about the hardware and software for that
system type as well as access some online publications.

If you click Profile than you can build a profile for that system so that you can be
informed of future updates via e-mail. We recommend that you set up a profile for
all your hardware and that you initially access the drivers to make sure your
systems are up to date.
18 Universal Manageability: Enterprise Management Integration



Figure 31. IBM Personal Computing Support

2.1.2.2 Information
When you click the Information tab there is a lot of system-type information you
can access. In Figure 14 on page 10 you can see the main page that you get
when you access the tab. It includes hardware and software information. If you
want to get more specific information you can click the other fields. For example,
when you click Drives you get information about your local hard drives as well as
some information about your LAN drives, CD-ROM and diskette drive. You can
easily see how much space is being used on any of the local drives.

Figure 32. Hard Drive Information - Used and Free Space

The memory option shows you what type of memory and how much of it is
currently installed. In addition, you can see what your options are for upgrading
the system.
Chapter 2. UM Services Installation and Operation 19



Figure 33. Memory Options

You can display information about the audio and video ports on the system as
well as operating system information. You can access information about the
current service pack installed, the license key, a current process list, the drivers
that are installed on the system and the services that are started.

Figure 34. Operating System Information

If you click Ports you get information about all the ports on the system.

Figure 35. Ports

Under Monitors you can view all the events (system, security and application). In
addition, if you click System Health you are provided with the following status:
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Figure 36. System Health
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Chapter 3. SMS 1.2 Upward Integration Module

Microsoft Systems Management Server (SMS) is part of the Microsoft Backoffice
package offering solutions for software and hardware inventory, software
distribution and remote troubleshooting tools. We used V1.2 with Service Pack 4
installed. Also, SMS needs SQL server to store the information and we used SQL
6.5 with its Service Pack 4. Chapter 4, “SMS 2.0” on page 63 discusses V2.0 of
SMS.

3.1 Requirements

According to Microsoft, the minimum hardware and software required to install
the Microsoft Systems Management Server V1.2 is:

• Pentium 133 or higher processor

• 64-96 MB of RAM (128 MB of RAM recommended)

• 1 GB available hard disk space

• Microsoft Windows NT Service Pack 3 or later

• Microsoft SQL Server 6.5 with Service Pack 4 or later

Note: SMS needs to be installed on a Windows NT domain controller (PDC or
BDC). The SMS server needs to be installed in the same machine as SQL server.
In addition, you must install the upward integration module onto the SMS 1.2
server.

3.2 Installing the Upward Integration Module for SMS

After downloading the UM Services code and unzipping it into a single directory
as shown in 2.1, “Installation” on page 4 run, setup.exe.

Figure 37. The setup.exe Location
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The next screen is the Welcome Screen. Just click Next. Then, the setup process
will ask which language to use. In our case we clicked English. After that you are
prompted with the license agreement information.

After these initial screens you have to choose what setup type is right for your
environment. Since you are going to install the upward integration module (UIM)
for SMS you need to choose the second button.

Figure 38. Installing the UIM for SMS

After clicking Next, you have to choose which UIM is to be installed. Click SMS
Upward Integration.

Figure 39. Choosing the UIM

After that, the system will ask with which version of SMS you plan to integrate.
For this chapter we used SMS V1.2.
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Figure 40. Choosing the SMS Version

After that, you receive a successful installation message and you need to restart
the system.

3.3 Discovery

After installing the UIM for SMS, Microsoft SQL Server V6.5 and SMS 1.2 with
Service Pack 4, we configured a client machine. Our environment was very
simple: one server with SMS and SQL Server installed. Also, we installed UM
Services with the UIM for SMS. The client machine was configured with the UM
Services agent and the SMS client.

Figure 41. SMS Environment

To install SMS you may have to run (on the client machine) the program
runsms.bat, located on the server in the directory \SMS\Logon.srv\. You have to
map the server directory to be accessed by the client.

From the client machine, click with the right button the My Computer icon.
Choose Map Network Drive. A new screen appears. Choose one drive letter in
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the first field. Then you need to know the domain and the name of the SMS
server. You can select the computer from a list of Shared Directories. In our case,
the domain was SMSDOM and the computer name was NTSRV101. The batch
file that we need to run is on the Shared Resource called SMS_SHRD. By clicking
this folder, the path field gets filled in.

Figure 42. Mapping the SMS Server’s D Drive

After that, click OK and open a DOS window. Change the drive to the drive that
you have mapped (in our case, H:) and change the directory to \logon.srv.

Then, run the file runsms.bat.

Figure 43. Running the runsms.bat File

After installing the client, a screen gets displayed and you need to fill in some
fields about the machine.
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Figure 44. Filling in Data about the Client Machine

The data gets stored at the server (in an SQL server database) and can be
accessed by the SMS administrator. The system will ask to reboot the machine in
order to enable remote control and start two services: SMS Client Inventory and
SMS Remote Control Agent.

Figure 45. Services Started by SMS Client

One of the services, the SMS Remote Control Agent, needs to have permission
to take control of the desktop. Clicking the Startup button at the Services screen
shows the logon characteristics. The box Allow Service to Interact with Desktop
must be checked to allow the SMS server to take control of the client machine.
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Figure 46. The SMS Remote Control Agent Startup Configuration at Services

At that point the SMS client installation is complete. From the SMS server, launch
the SMS Administrator.

Figure 47. Launching the SMS Administrator

The first screen calls the login process to access the SMS Administrator. Enter
the user ID and the password.
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Figure 48. Logging In the SMS Administrator

After logging in, you have to choose an SMS window to work from. If you choose
the Sites window, you can see detailed information about the environment
(domains and machines).

Figure 49. Choosing the Sites

After choosing Sites, you can see the Site (it was created during the SMS
installation), the domains in the Site and the computers in the domain.

Note: For more information about the SMS Server installation, see the redbook
Universal Management Agent: Functions and Integration, SG24-5294.

Figure 50. The New Client Installed

If you double-click the machine WTR0531, you can get more information about
the system. SMS and Windows NT provide you with the following types of
information:

• Identification
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• Workstation Status

• Processor

• Operating System

• Network

• Netcard

• Disk

• PC Memory

• Video

• Mouse

• Services

• Environment

• Help Desk

• Windows NT Diagnostics

• Network Monitor

• Windows NT Administrative Tools

• DMI (Distributed Management Interface)

• User Information

Note: The last two items are only available for client machines.

Figure 51. User Information from the Client Machine

The UM Services upward integration module provides you with more information.
To enable the UM Services features in the SMS Administrator, you have to first
install the UM Services upward integration module for SMS in the server machine
(see 3.2, “Installing the Upward Integration Module for SMS” on page 23).

The clients need to have installed the UM Services code as well (see 2.1,
“Installation” on page 4).

At the client machine, go to the path where the UM Services agent was installed.
In our environment, the path was: D:\Program Files\IBM\UMS.
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Inside the path where the UM Services folder is, we had to create a directory
called noidmifs. It is possible that the directory might be created automatically for
you. You should verify that it is there.

Copy into the new directory (noidmifs) a batch file called smsinv.bat which is
located in the directory D:\Program Files\IBM\UMS\inventory.

Figure 52. Creating the noidmifs Folder and Finding smsinv.bat
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Figure 53. The Batch File smsinv.bat

It’s very important to copy the file to the right place. Otherwise, the integration will
not work. After executing these steps, run the smsinv.bat file from a DOS window
in the client machine.

Figure 54. Contents of the smsinv.bat File

@echo off
%UMS_DRIVE%
cd %UMS_HOME%\inventory
jview -d:WINDIR=%WINDIR% -cp:a .\cim2mif.jar;

"%UMS_HOME%\httpserv\cimdre.jar";
"%UMS_HOME%\httpserv\cimxml.jar";
"%UMS_HOME%\httpserv\guitools.jar";
"%UMS_HOME%\httpserv\mswmi.jar";
"%UMS_HOME%\httpserv\xml4j_1_1_14.jar" com.ibm.sysmgt.cim.cim2mif.cim2mif /SMS

dmi2sms @dmi.lst
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Figure 55. The smsinv.bat File Execution

After executing the batch file, the SMS administrator program receives
information about that client and it adds some features to its menus and
properties. In addition, the MIF files that are generated are copied into the
noidmifs directory so that they can be processed by SMS.
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Figure 56. New Features Incorporated by UM Services

Beyond the standard information that SMS provides, there are new features for
the client machine that UM Services provides:

• Network Details

Figure 57. Network Details

• Video Details
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Figure 58. Video Details

• System Slots

Figure 59. System Slots

• Lease Information

Figure 60. Lease Information

• User Details

Figure 61. User Details

• Common Information Model (CIM)
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Figure 62. Common Information Model

• BIOS Details

Figure 63. BIOS Details

• System Enclosure

Figure 64. System Enclosure

• AssetID

Figure 65. Asset ID
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• Serial Number Information

Figure 66. Serial Number Information

• IP Network Configuration

Figure 67. IP Network Configuration

• IPX Network Configuration

Figure 68. IPX Network Configuration

• Port Connectors

Figure 69. Port Connectors
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• IBM UM Services

Figure 70. IBM UM Services

• Processor Details

Figure 71. Processor Details

• System Board Configuration

Figure 72. System Board Configuration

• Warranty Information

Figure 73. Warranty Information

• Memory Details
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Figure 74. Memory Details

• Cache

Figure 75. Cache Information

• Personalized Data

Figure 76. Personalized Data

The Tools menu was modified as well. There are three more functions on it (for
this client):

• Issue Wake-on-LAN request

• UM Services Management Tools

• UM Services Update Client Inventory
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Figure 77. NewFeatures on the Tools Menu

3.4 Launching UM Services from SMS

The UM Services can be launched from SMS. To access a specific client, all the
UM Services features are available through the browser (Netscape or Internet
Explorer), including remote control.

3.4.1 Issue Wake-on-LAN Request
The Wake-on-LAN feature provides the capability to remotely power on systems
supporting Wake-on-LAN by sending a wake-up frame. With this feature, it’s
possible to upload/download data to and from the systems involved during off
hours.

Figure 78. Issue Wake-on-LAN Request
40 Universal Manageability: Enterprise Management Integration



To use the Wake-on-LAN features, you need to have a Wake-on-LAN compatible
LAN card in the client machine.

Beyond the software configuration, you may have to configure the hardware. On
the BIOS of IBM machines, you can set up and turn on the Wake-on-LAN
features.

To configure the BIOS on the client machine, you need to power it down and back
up and then press F1 to enter setup mode. The procedure to set up the
environment requires the following steps at power up time:

• Choose Start Options

• Primary Startup Sequence - Leave it set as it is.
• Automatic Power on Startup Sequence - Change to [Enabled]
• First Startup Device - Change to [ Network ]
• Second Startup Device - Change to [Hard disk 0]
• Error - Change to [Automatic]

• Choose Power Management

• ACPI BIOS - Change to [disabled]
• APM - change to [enabled]
• Automatic Power On

• Choose Wake-on-LAN

• Wake-on-LAN - Change to [enabled]
• Startup Sequence - Change to [Automatic]

Then save all your changes and reboot the system.

3.4.2 UM Services Management Tools
Launching the UM Services browser using SMS is very simple. You just need to
open the SMS Administrator, go to the Tools menu and choose UM Services
Management Tools.

Figure 79. Launching the Browser
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The next screen asks for the user name and password to access the client
machine. This user ID was created when the Agent was installed.

Figure 80. Accessing the Client Machine with a Browser

Figure 81. Verifying UM Services Installation

When you use the browser (Netscape or Internet Explorer) to access the UM
Services agent, a screen indicating that the UM Services installation is being
verified appears. This screen appears each time that this option is selected. This
verification is necessary to verify that all the modules are installed.

Note: Since this was the first time we had accessed the agent with Internet
Explorer, we received an alert from the system indicating that our system didn’t
have all the modules required. However, the alert showed how to get those
modules and how to install them. We downloaded these files from the client
machine into D:\Program Files\IBM\UMS \httpserv. They were zipped files and
after their installation we had to reboot our server and we were able to use the
UM Services browser functions. See Figure 82 for more details. Also it’s very
important that you check what browser is being used as default. The modules will
be updated only for the default browser.
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Figure 82. Warning about Missing Java Libraries

After rebooting the server, go back to the Tools menu and choose UM Services
Management Tools. The screen that pops up asks you for the user name and
password. After entering them, the UM Services data from the client machine is
transferred to your browser.

Figure 83. Browser with Client Machine Data

Using the browser, you have access to all of the IBM features in the client
machine. Also, you can get control of the client using the Remote Control option.
This option is located at the Tasks folder under Tools.
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To take control of the client machine, you have to configure (at the client machine)
the Help Desk Options.

Click Start -> Programs -> SMS Client -> Help Desk Options.

Figure 84. Accessing the Help Desk Menu

After clicking Help Desk Options, the following figure appears:

Figure 85. Help Desk Options

At this screen, you can configure the options that the server will access, for
example, remote control and chat.
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We checked all the options, and then we clicked Save as Current. After that, the
client machine was ready to be taken over by remote control.

Figure 86. Starting Remote Control with UM Services

At the browser screen, in the Tasks folder, choose Tools and Remote Control.
Click the Start session button and a new screen with the remote console is
opened.

Figure 87. Remote Control of the Client Machine
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At the client machine, a minimized window on the taskbar will appear, indicating
that the machine is being controlled by the server. At that point in time, only the
server can operate the machine. The keyboard and the mouse on the client
machine stay locked until the server terminates the session.

3.5 Inventory

To gather information about the clients, we clicked the UMS Update Client
Inventory option on the Tools menu.

Figure 88. Accessing the UM Services Inventory Option

This option opens the browser again and asks for the user ID and password. It
shows a window similar to Figure 89. After clicking the button, UM Services starts
to gather the inventory information and sends it to the SMS database.

Figure 89. Gathering Inventory Information using UM Services

After the data collection process completes, another screen appears indicating
the end of the process.
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Figure 90. End of Gathering Process

When SMS performs the next Inventory scan, the information generated by UM
Services will be included.

3.6 Software Distribution

To distribute UM Services to client machines, you have to create a package and a
job on SMS. The software distribution process in SMS is based in Package
Definition Files (PDFs). The PDF file (*.PDF) is a script that contains all the
necessary steps for software installation.

After installing the SMS upward integration module on the server, a UM Services
PDF will be placed in the directory ..\IBM\UMS. Its name is UMS.PDF.

Note: In this process we need to use the UM Services installation folder (the
same one that was used for the Agent installation or the UIM installation). In order
that the client machines have access to that folder, you need to make the folder
shared.

In our environment, the UM Services installation files are in the directory
E:\Ums-last\Win32\Install.

Figure 91. Path to the UM Services Installation Files
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With the right button click the Install folder and choose Sharing on the menu
that appears.

Figure 92. Sharing the UM Services Installation Folder

You need to choose a Share Name for the folder. We used UMINST. Type the
name and click OK. Looking at the Windows Explorer, a small hand icon will
appear indicating that the folder is shared.

Figure 93. The Folder’s Share Name

Then you have to map this folder as a network drive. In Windows NT Explorer,
below the menu, there is a button called Map Network Drive.
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Figure 94. Mapping the Network Drive

Clicking that button causes a new window to appear. The process to map the
folder will be the same as indicated in Figure 42 on page 26. But here, we type
the name of the server and the shared name that we created.

Figure 95. Mapping the Drive

If you look at the Windows NT Explorer you can see the new mapped drive. If
it does not show up, you should referesh the list.

Figure 96. New Drive Added to Windows NT Explorer

After this preparation task is completed you can go back to SMS. You have to
create a package.

On the SMS Administrator, click File -> Open.
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Figure 97. Accessing the Menu

Figure 98. Choosing a Window to Open

A window appears with the created packages. At this point in time we had not
created any packages so the window was empty.

Figure 99. Package Window

Since the package for UM Services distribution is ready, you need to import the
UMS.PDF into this window.

At the main menu, click File -> New.
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Figure 100. Creating a New Package

A window called Package Properties will be opened. On the right side you can
see four buttons. The third is the Import button. Click it.

Figure 101. Importing the UMS PDF File

A browser window is opened. Use the directories list to browse the folder where
the UMS.PDF is located. In our environment the file was in D:\program
files\ibm\ums.

Figure 102. Browsing the UMS.PDF File
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As we indicated, the PDF file contains a script with information about the
installation process. In Figure 103 we show the contents of the file.

Note: This PDF was not finished when we wrote this book. The
UMSW32UM.EXE file was not ready to make an unattended installation. In our
case, we created a package and a job to start a standard installation. It is
available on the CD in \Install|file Packages\SMS.

Figure 103. The UMS.PDF File

After importing the UMS.PDF file, a screen with the UM Services data appears:

Figure 104. The UM Services Data Package Properties

The next step is to click the Workstations button. The field Source Directory
must be filled in with the path of the installation file. By clicking the (...) button you
can browse the directories to find the path. The path for our installation was the
drive that we mapped earlier.

Note: We used the path for the UM Services installation files. When the
UMSW32UN.EXE is ready, it will point to the correct path.
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Figure 105. Setting Up the Package

Click the Properties... button and another screen will appear. That screen needs
to be filled in with the name of the installation file and each system on which it is
going to be executed.

Since you are using the UMS.PDF, that field appears filled in with the name of the
installation file:

Figure 106. The Command Line Properties

We clicked the (...) box and changed the path to setup.exe on the mapped drive:

Figure 107. Changing the Command Line
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We also changed the supported platform to install on Windows NT (in our
environment, the client machine is another Windows NT Server).

Click OK and you go back one screen in the process. Click Close and you go
back to the first screen, Package Properties. Click OK.

A system message appears indicating that all sites (we just had one) will be
updated. Now the package is ready.

Figure 108. UM Services Package Ready

Now you need to create a job to run the package.

Like the Package creation option, on the main menu click File and Open. That
brings you to a window similar to Figure 98 on page 50. Choose Jobs.

Figure 109. Jobs Window

With the Jobs window selected, go to the main menu again and click File -> New.

The Job Properties window will be opened:

Figure 110. Job Properties

You have three types of Jobs:

1. Run Command on Workstation

2. Share Package on Server

3. Remove Package from Server
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Figure 111. The Job Types

The first one (which we used) runs a command (usually a file) on a workstation.
The second one will share a package on a server, so the clients can access the
server in order to install code. The third one removes a package from the server.

Click Details and a new window is opened.

The Package name field contains a list of the packages on the server. Figure 112
shows the UM Services package that we created. If you create more packages,
you can select them from the list.

The Job Target field should be filled in according to the machines that should
receive the package. It can be a group or only one machine.

You can also configure the phase to send the package.

Figure 112. Job Details

In our case, we configured the package to send UM Services to All Personal
Computers. Click OK to go back to the Jobs window.

The Job Schedule window allows you to determine the day, hour, priority and
frequency of the job.
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Figure 113. Job Scheduling

After configuring the schedule, click OK to go back to the Jobs window.

The third button shows the job’s status. After running it, you can check to see the
status of the job. Click the Close button to go back to the Jobs window.

Figure 114. Job Status

After everything is configured, click the OK button in the Jobs window, and the job
will be queued.

Figure 115. The Job Queue

As soon as the job starts (depending on the time that you scheduled to start), the
client machine will automatically open the Package Command Manager.
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Figure 116. Package Command Manager on the Client Machine

The Package Command Manager opens automatically and shows the status of
the job. Click Details to get some information about the job.

Figure 117. Details from Package Command Manager

Click Execute in Figure 116 and the job will start to run. In our case, it ran
SETUP.EXE, which was located on the server.

Note: Since you configured the job for a standard installation, you may have to
continue the installation manually (choosing the options during the installation).

Figure 118. Starting the Installation on the Client Machine

3.7 Alerts

To prepare SMS to receive UM Services traps (a UM Services trap is an SNMP
packet sent from one SNMP entity to another, in response to an event), you have
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to configure the Site Properties. On the SMS Administrator main screen, select
the domain where the workstation with UM Services is located. Click File ->
Properties. A screen with the site properties will appear.

Click the SNMP Traps button.

Figure 119. The Site Properties

After clicking the SNMP Traps button a new window opens. Select Proposed
Properties (the radio button) and click the Create button.

Figure 120. SNMP Trap Window
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Figure 121. SNMP Trap Properties

We included a short description and marked the OID radio button. We entered
1.3.6.1.4.1.2.6.159.1.1.0.1.1.4. To check the data that was included, click OK.

Figure 122. The SNMP Trap Included

The next step is to configure UM Services to send the traps to the server. From
the UM Services screen (it can be accessed by SMS through the Tools menu,
followed by UM Services Management Tools), click the Tasks folder. There are
three subfolders:

1. Configuration

2. Tools

3. Web Links

At the Configuration folder, click SNMP.
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Figure 123. SNMP Configuration on UM Services

We need to include the community name and the trap destination. Click the Add
button (beside the box) and a box will be opened to enter the name.

Figure 124. Entering the Community Name on SNMP Configuration

To insert the destination of the traps, you have to click the Add button (below the
Trap Destination box).

Figure 125. Entering the IP Address on SNMP Configuration

After adding the community name and the IP address click Apply.
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Figure 126. The SNMP Screen Configured
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Chapter 4. SMS 2.0

The new version of Microsoft System Management Server has the same basic
requirements for installation as V1.2 did, but its interface has changed.

After the SMS server installation, we installed the UM Services upward
integration module (UIM) for SMS 2.0. The procedures for this installation are the
same as SMS 1.2. Refer to 3.2, “Installing the Upward Integration Module for
SMS” on page 23. The only difference is in Figure 40 on page 25. We chose SMS
2.0 Upward Integration to reflect the later version of the product.

Figure 127. Choosing the SMS 2.0 Upward Integration Module

After the installation, we launched the SMS Administrator Console.

Figure 128. Launching SMS Administrator Console
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4.1 Discovery

To initiate the discovery of clients in SMS, you have to configure the Client
Installation Methods under Site Settings. Click with the right button Windows
Networking Logon Client Installation -> Properties.

Figure 129. SMS Administrator Console

After clicking Properties, a new window will appear. In this window, you have to
enable the Windows Networking Logon Client Installation. The next time that the
client machine connects to the domain server, SMS will include this machine in its
database.

Figure 130. Enabling the Windows Networking Logon Client Installation
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There is another tab called Logon Settings for the networking properties. You
need to choose this option to enable the logon script modification.

Figure 131. Changing the Logon Script Settings

After clicking OK, the system will return to the Client Installation Methods folder.

Next you have to configure the information that the server will gather on the client
machine. Choose the Client Agents folder under Site Settings.

Figure 132. The Client Agents Folder

The first agent is the Hardware Inventory Client Agent. Click with the right button
and choose Properties. Check the box Enable hardware inventory on clients.
You should also configure a schedule for it.
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Figure 133. The Hardware Inventory Client Agent Properties

Click OK and return to the Client Agents folder. Choose Software Inventory
Client Agent by clicking the right button and selecting Properties.

As with the hardware properties, enable the check box Enable software
inventory on clients.

Figure 134. The Software Inventory Client Agent Properties
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Getting the inventory into SMS V2.0 is provided by the Windows management
instrumentation included in UM Services. This is done during an SMS hardware
inventory scan on the client and the creation of the MIF files. When a user installs
UM Services on his or her SMS client, it adds a class to the root\cimv2\sms
namespace called IBMPSG_SMS_Inventory_scan. This class is a child of the
SMS_Class_Template class. SMS looks for child classes of SMS_Class_template
during inventory scans to tell it which WBEM objects to query for inventory
information. When SMS finds IBMPSG_SMS_Inventory_Scan, UM Services
loads a CIM provider that in turn generates NOIDMIF files and writes them to
\ms\sms\noidmifs. After SMS processes all of the SMS_Class_template classes,
it scans \ms\sms\noidmifs and processes any MIF files that exist there. Once the
inventory for a client has been added to the SMS database, the user can open the
SMS Resource Explorer for that system and view both the SMS inventory
information as well as information provided by SMS Services.

When UM Services senses an abnormal environment condition on an IBM
system, it writes an entry to the UM Services System Health log and it generates
a CIM event. The CIM event is translated to an SMS status message in SMS
environments so that it will be visible from the SMS System Status Viewer in the
SMS Admin Console.

In Figure 134 click OK to go back to the Client Agents folder. To enable the
remote tools on the client, such as remote console, you have to configure the
Remote Tools Client Agent.

Click with the right button and choose Properties. Check the box Enable remote
tools on clients.

Figure 135. Remote Tools Client Agent Properties
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To start the discovery process you may have to (from the client machines) log in
to the domain server again (that runs the logon script). After that, it will take a
little bit of time until the server recognizes the clients.

After the discovery occurs, the Control Panel on the client machine will be added
with new options.

Figure 136. New Features on the Client’s Control Panel

The new features added are:

1. Advertised Programs: Shows the programs scheduled to run on the client
machine.

2. Advertised Programs Monitor: Controls the programs scheduled, their activity,
and problems.

3. Remote Control: Since we configured the server to allow remote control of the
client machines, this feature shows the settings and the status.

4. Systems Management: Shows general information about the system, network
configuration, sites and the components installed.

For the SMS server, UM Services includes new features for V2 of SMS.
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Figure 137. New Features in the SMS Interface

In the Collections folder (where the systems are organized), a new collection will
appear. It’s the All systems with UMS client collection, which will join the systems
where the UM Services Agent is installed. To access one system, you need to
right-click a machine, choose All Tasks and then UM Services Point-to-Point
Tools. A new frame (in the Microsoft Management Console (MMC)) will be
opened with all the information about that system. Also, you can choose
Wake-on-LAN to send a wake-up command to a machine (the machine needs to
have the appropriate hardware and be configured to use this option - see 3.4.1,
“Issue Wake-on-LAN Request” on page 40).

Figure 138. Accessing System Information Using MMC
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Also, in the Queries folder, a new collection will be included by UM Services. The
query is a set of criteria used to find objects in an SMS site database. As with the
collection, the query All Systems with UMS client, is included.

Figure 139. New Query on SMS Interface

In the Tools folder, a new feature called UMS Point-to-Point Tools will be added.
This feature launches the MMC, which has all of the UM Services Systems in a
separate frame. The MMC’s view is equivalent to the browser (on SMS V1.2), with
the same functions. Only the interface has changed. But if you want to use the
browser, there is no problem. The process is the same as on SMS V1.2. Please,
refer to 3.4.2, “UM Services Management Tools” on page 41.

Note: Since MMC uses the Internet Explorer features to load the data if your
default browser is not the Internet Explorer, you’ll need to update the libraries. If
the MMC is not working properly, check Figure 82 on page 43 to see the libraries
that might be missing.

Figure 140. The UM Services Point-to-Point Tools Folder
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To access any folder in the SMS interface you need to use the right mouse button.

Looking at Figure 137 on page 69, you can see that UM Services includes the
Point-to-Point Tool to access a specific machine. But, in the Tools folder (as you
can see in Figure 140 on page 70) you can use the MMC to access all of the
systems.

Figure 141. The UM Services Console Launched Through the Point-to-Point Tool

The UM Services Console has the same functions as the browser. You can see
that in the next two figures:

Figure 142. System Options Using the MMC
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Figure 143. System Options Through the Browser

Note: To access the systems from a browser you need to start it manually. There
is no option to launch the browser through SMS.
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Chapter 5. Tivoli NetView Upward Integration Module

The UM Services Upward Integration module for Tivoli NetView was installed on a
Netfinity 3000 Server (model 8476-21U) that was running Windows NT V4.0 with
Service Pack 4 installed. Windows NT was installed as part of Backoffice V4.5. In
addition, since we needed a database to work with Tivoli NetView we installed
SQL V7.0 that was also part of Backoffice V4.5.

We installed the latest level of code for Tivoli NetView (V5.1.1). You need to make
sure that your ODBC-compliant database is installed before installing Tivoli
NetView. In addition, you should make sure that the SNMP service is installed
and started.

While the focus of this chapter is the integration between UM Services and Tivoli
NetView we show some of the setup that occurred in order to achieve the
integration points.

To install Tivoli NetView V5.1.1 execute the setup.exe module:

Figure 144. Tivoli NetView Initial Window

You need to make sure that you have enough disk space to install the product as
well as disk space for the various databases that Tivoli NetView will build and
maintain. This of course implies that you need to install your database product
before you install Tivoli NetView.

Figure 145. Disk Space
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You can choose to install the server code, the client code or both. We chose
Single User (both).

Figure 146. One Machine - One Client Server

You will be prompted for a user ID and password that Tivoli NetView can use to
modify your system. In our case we used the default ID that was suggested
(NetView).

Figure 147. Administrator User ID

In most cases you should select Discover Only Local Networks since discovering
all networks will produce lots of network traffic and possibly cause some traffic
slowdowns if you do not have enough bandwidth. You can use a seed file once
Tivoli NetView is up and operational to manually add other subnets. The default
location of the seed file is \usr\ov\conf\netmon.seed. You can use wildcards to
specify addresses or you can use specific addresses and NetView will broadcast
its discovery through that subnet. In addition, you can manually add other
subnets while the Tivoli NetView console is running. That is done by clicking the
Options pull-down menu followed by Server Setup.
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Figure 148. Discovery

Tivoli NetView uses SNMP broadcasts to perform its discovery. In addition to
using the default community name of Public you can enter other community
names that it will use during its broadcast search.

Figure 149. Community Names

Click Continue for the rest of the installation to occur. If you have an ODBC
database installed you will see the left-hand figure in the following window. If you
have not yet installed a database you will get the error message in the right-hand
part of the following window:

Figure 150. Database Installed or Database Not Installed
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For the purposes of discovering what UM Services are available we used the
default configuration parameters that were available with the SQL 7.0 installation.

Figure 151. SQL 7 Settings

After the installation of Tivoli NetView has completed we rebooted the system and
clicked Start -> Programs -> NetView -> Administration -> Server Setup. The
following window shows that all of the daemons are up and operational. Since we
know that our NetView environment is working it is OK to install the UM Services
integration component. We had already installed the UM Services base
component on this system before we installed Tivoli NetView.

Figure 152. Server Setup

To install the integration component you run setup.exe (just as you did when you
installed UM Services). After the Welcome window click Next.
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Figure 153. Initial Installation Window

After clicking Next, select the language and acknowledge the license agreement.
The next window is for installing the integration component. While it is not a
requirement that you also install the UM Services component on the same
system as your Tivoli NetView console, we performed that task earlier (see 2.1,
“Installation” on page 4).

Figure 154. UM Services or Integration Module

In addition to the Tivoil NetView integration module there are also upward
integration modules (UIM) for CA Unicenter, SMS and Intel Alert on LAN. For this
piece of the install process click Tivoli NetView Upward Integration.
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Figure 155. Tivoli NetView UIM

There are no other installation choices to make other than clicking OK the
following window:

Figure 156. Installation Successful

The installation process adds:

• A UM Services SmartSet
• V2 MIBs
• Online help panels
• Configuration information for trapd.conf
• New icons for UM Services
• Information to nvsniffer.conf (isUMSHttp, isUMSSnmp and isUMSCim) so that

it can find UM Services in the network

After you have installed the UM Services and the integration component you need
to reboot your system. After your system has rebooted you are almost ready to
access the new functions.

5.1 Discovering UM Services Clients

Tivoli NetView has an application called nvsniffer that does a broadcast discovery
of different classes of devices out in the network. When we installed the
integration component it added some configuration information to the file
\usr\ov\conf\nvsniffer.out. The following lines of coded were added:
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The command that you need to run before you restart Tivoli NetView is:

nvsniffer -l logfile -v

It runs the sniffer and places the output in a file as well as in a command prompt
window so you can see the discovery process occurring. To retrieve inventory
information for a system, isUMSCim must be enabled when running nvsniffer. If
the user wants to run nvsniffer and just have it runthe UM Services-specific tests
they can use the following command:

nvsniffer -c nvsniffer_ums.conf -v

To view data for a specific system use:

ovobjprint -s systemname

Note: Be sure to uncomment the lines that have UMS search criteria on them.

Figure 157. Discovery Process

The nvsniffer application searches your already discovered devices to find
specific applications (by port number). When you installed UM Services the
default port that was provided was 411. The nvsniffer application groups
applications logically into objects called SmartSets. These SmartSets are
automatically populated for you as part of the nvsniffer application. The

##################################################################
# UMS nvsniffer discovery
#
#discover UMS agent by testing the SNMP OID
#isUMSSnmp|.1.3.6.1.4.1.2.6.159|||\usr\ov\bin\snmpsniffext.dll|
\usr\ov\bin\snmpsniffext.dll|*
isUMSCim||||\usr\ov\bin\umscimtest.dll|\usr\ov\bin\umscimtest.dll|*
isUMSHttp|411,6500,6411,6611,6600|UM_Services|Universal Management
Services|\usr\ov\bin\umshttptest.dll|\usr\ov\bin\umshttptest.dll|*
#Create tools (UMS agent and Netfinity Director) within the UMS systems
#isUMStool||||\usr\ov\bin\sniffEAR.dll||UMSSystems
#
#######################################################################
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UM_Services SmartSet gets created as part of the installation of the NetView
integration module.

You should have the Tivoli NetView console interface down when you run
nvsniffer. Even though the console interface is not operational the daemons are
still running in the background.

The installation of the UIM modifies the Tools menu. It adds two items:

1. Universal Manageability Services - To launch a browser.

2. UM Services Inventory - To display inventory information.

Figure 158. Tivoli NetView Tools Applications

The following window shows the output from a few of the inventory categories:
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Figure 159. The Results of Different Inventory Queries

From the Tivoil NetView console you can either click your way through the
submaps to find specific devices or you can search for them. Since we had
selected to discover only our local subnet it was very easy to find our system:

Figure 160. 9.89.40 Segment

If you right-click barryps2 you can see what properties are associated with it. You
should look at the Capabilities tab:
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Figure 161. Capabilities

When you click the Events tab you can see what events have flowed through
Tivoli NetView for this device. Notice that a few of them are UM Services related.

Figure 162. Events

If you go to the Tivoli NetView console initial window and click SmartSets you get
a list of all the different types of applications that have registered. If nvsniffer has
discovered (through its broadcast mechanism) devices that are operational you
should see the SmartSets show up in green. For example, if you look at the last
row you can see the one for UM Services.
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Figure 163. SmartSets

If you double-click UM Services you get a window that shows all the discovered
UM Services systems. From that window you can launch the Web browser or
review inventory-related information.

Figure 164. SmartSet Discovered Devices

If you click Universal Manageability Services your Web browser gets launched
and you are prompted for the user ID and password to access UM Services
information on that agent.

nvsniffer output goes here
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Figure 165. Security Check

After the security check is complete you get the regular UM Services browser
window.

Figure 166. UM Services Browser Interface

Go back to Tivoli NetView and find your UM Services system. Right mouse click
and select Explore:
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Figure 167. Explore

The resulting window shows you all the capabilities for that system.

Figure 168. SmartSets View

There are a few MIBs that are provided (and installed with) the UM integration.
You need to use the MIB2 browser and loader rather than the older MIB
application. You can manually start the MIB2 browser from
\usr\ov\bin\loadmibv2.exe. If you need to load a new MIB, click Load. The MIBs
that are provided with UM Services are:

• cimwin32.mib

• ums.mib

• umsagent.mib

• umsaol.mib

• umsevent.mib

• umsvpd.mib
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Figure 169. MIBs Already Loaded

To browse the contents you need a MIB2 browser. It is located in
\usr\ov\bin\browserv2.exe.

Figure 170. .iso.org.dod.internet.private.enterprises
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You can also see all of the Tivoli NetView events. You can filter which events flow
through Tivoli NetView as well as customize specific actions to occur as a result
of the event occurring.

Figure 171. nvevents

To be able to see and set Trap settings you need to make sure that the console is
running in advanced mode. In the Tivoli NetView console click the Options
pull-down menu and select Advanced Menu if it doesn’t already have a check
mark next to it. Then shut down and restart the Tivoli NetView console interface.

Figure 172. Advanced Menu Settings

Then click Trap Settings.
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Figure 173. Trap Settings

To change some of the actions, click Properties.

Figure 174. Trap Properties
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Chapter 6. Tivoli Framework and Plus Module

This chapter shows how to integrate the Tivoli Plus module with UM Services. We
show the installation of the framework and the Tivoli Plus module as well as many
of the individual functions since the setup of the environment is an important
prerequisite to having all of the Tivoli Plus module’s functions enabled.

In our case we used a Netfinity 3000 Server running Windows NT 4.0 with
Service Pack 4. In addition, since the level of the Tivoli Framework that we used
(V3.6) did not support DB2 (V3.6.1 does) we used Microsoft SQL for our
database support. After the project completed we did some testing with V3.6.1
and DB2 V5.2 and we did use many of the functions.

Our first step was to install the Tivoli desktop environment. While the desktop GUI
interface could have been installed on any of our systems, we installed it on the
same one as the framework. In addition, for this chapter we only used Windows
NT. While AIX is supported for the framework and the Plus module (as are other
platforms), there was no additional benefit to using it (or any other Tier-1
operating system) since the UM Services interface only applies to the Windows
environment. The clients that you are operating against must be Win32, but not
the Plus module interface itself.

We ran setup.exe from \Pc\Desktop\Disk1\ to install it.

Figure 175. Install the Tivoli Desktop

That is the last prompt that you will have for the desktop installation. Following
that you can begin to install the framework. It is on the same CD-ROMbut the
setup.exe is in the root directory. Run it and you will be prompted to enter your
name and your company’s name.
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Figure 176. User Information

After clicking Next you are prompted to enter an installation password. You need
to remember this password as it is used to install Tivoli-related software on other
machines. For example, if you are going to create a managed node you need to
know the installation password. When you enter it, it is not blanked out.
Therefore, you are not prompted to enter it twice.

Figure 177. Password

When you install the Tivoli framework it should be done with the administrator
user ID. Even if another ID has administrator rights we have found that there can
be some problems. After it is installed you will be able to add other user IDs and
access it from the other IDs. For the installation to be successful your
administrator ID needs to have access to the file systems that it will store data on,
on all systems in the infrastructure. This should not be a problem with most
administrator IDs.
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Figure 178. File Access

You can run Typical, Compact or Custom; we chose Custom. In most cases it’s a
good idea to select custom so you can see what the different options are.

Figure 179. Prepare for Installation

After clicking Next we selected all of the components in the following window:
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Figure 180. Tivoli Framework Components to Install

You need a license key to proceed. If you don’t have one, there is no other way to
continue. While this install was on the Windows NT platform, the same is true for
all platforms.

Figure 181. License Key

After entering your license key click Next and decide in which directory to store
the database. You should be using an NTFS drive for the installation of the
framework and the database.
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Figure 182. Location of the Tivoli Database

After the database is installed you need to reboot the system to be able to use the
code. You can either modify your environment variables or make sure your logon
script runs \winnt\system32\drivers\etc\tivoli\setup_env.cmd. A partial copy of it
follows:

set BINDIR=d:\Tivoli\bin\w32-ix86

set DBDIR=d:\Tivoli\db\barryps2.db

set o_dispatch=94

set INTERP=w32-ix86

set PERLLIB=%BINDIR%\tools\lib\perl

set TivPath=%BINDIR%\bin;%BINDIR%\tools;%BINDIR%\ADE;%BINDIR%\AEF

set Path=%TivPath%;%Path%

set TMP=%DBDIR%\tmp

set TEMP=%DBDIR%\tmp

set TISDIR=%BINDIR%\..\generic

set WLOCALHOST=

set NLSPATH=d:\Tivoli\msg_cat\%%L\%%N.cat

If you decide to update the system variables you need to click Start -> Settings
-> Control Panel -> System and then update the Environment tab.
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Figure 183. System Environment Variables

You should also check that the user ID administrator received the correct
privileges during the install:

Figure 184. Group Memberships

After installing the framework we installed a Managed Node and a PC Managed
Node. We did not provide all the details for this installation as it is provided in
many of the Tivoli product manuals as well as other redbooks.
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Figure 185. ManagedNode Installation

Figure 186. PCManagedNode Installation

The following window shows the topology we used for the rest of this chapter.
While it is not a large number of systems, it is enough to show how the various
functions work.

Figure 187. All of the Systems in Our Environment
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Once the framework and the systems were installed we needed to install the
database that we were going to use and the applications with which the UM
Services Plus module would integrate. We installed:

• Microsoft SQL V7.0

• Tivoli Inventory V3.6

• Tivoli Software Distribution V3.6

• Tivoli Enterprise Console (TEC) V3.6

• Tivoli Distributed Monitoring V3.6

• UM Services Plus Module

6.1 Microsoft SQL V7.0

We installed SQL V7.0 from the Microsoft Backoffice V4.5 CD-ROMs. This is not
a requirement. We could have installed it directly from the SQL product CD-ROMs
or we could have used SQL V6.5. In addition, with V3.6 of the Tivoli Framework
we could have used Sybase or Oracle as well. With V3.6.1 we could have added
DB2.

Figure 188. Install SQL V7.0

After clicking Next you are prompted to agree to the license considerations.

Figure 189. SQL License Agreement

Following the license agreement you can enter your name and your organization’s
name. This will be saved and propagated into other menus later.
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Figure 190. Name and Organization

You can have the system store, in the registry, the user ID and password of this
system. We did not choose to do this as it is a potential security risk. Upon
startup, the system would automatically log on. Unless this system is physically
and logically secure, check the box I will log on manually after restarts.

Figure 191. Auto Logon

After you click Next the installation of the setup files begins.

Since we installed from the BackOffice CD-ROMs we can get more specific as to
which functions get installed. Click Custom -> Next.
Chapter 6. Tivoli Framework and Plus Module 97



Figure 192. Customizing your BackOffice Installation

If you still had Microsoft Gopher installed from a previous release of Windows NT
it will be removed.

Figure 193. Removing Old Code

We only selected the SQL 7.0 components that we needed. You should consider
including the online books unless you are already familiar with SQL 7.0. As with
all products, you should not put the product code in the same drive as other
products that will be heavily used. You should not keep the database on the same
volume as your swap file or the code. We did not go beyond these basic tuning
points.
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Figure 194. Select Components

After the install begins you will be prompted to optionally set up the accounts that
will have access to SQL. In our case we clicked Assign Account(s) to set up the
administrator user ID.

Figure 195. Account Access
Chapter 6. Tivoli Framework and Plus Module 99



Figure 196. Password Setup for the Administrator ID

If you want more details about the purpose of the IDs you can click More
Information in Figure 195 on page 99.

Figure 197. What the IDs Are Used For

You should also verify that the protocols that are used are the ones you need. In
our case the default TCP/IP protocol and the default sockets were fine.
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Figure 198. Named Pipes and TCP/IP Sockets

You have one last chance to make any changes before the customization is
performed. The following window shows a summary of what you selected to be
installed:

Figure 199. Final Options

Figure 200. Restart
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After the system restarts it completes the rest of the installation process and SQL
7.0 is ready to use.

6.2 Tivoli Inventory

Now that the framework is in place and the SQL database has been chosen it’s
time to install Tivoli Inventory. During the installation of Tivoli Inventory you are
going to have to indicate which database (for example, Oracle, Sybase or SQL)
you are going to use. After the code is installed you have to create the SQL
database and then run some scripts that are provided with Tivoli Inventory.

After inserting the CD-ROM or downloading the install image you can use the
Tivoli desktop to install Tivoli Inventory. From the desktop click Desktop -> Install
-> Install Product. After you point to the correct media and directory you get the
following window:

Figure 201. Tivoli Inventory Components

When you click TME 10 Inventory, Version 3.6 you are prompted to specify the
database install options. We used the ones in Figure 202. Note that the Instance
Home field is left blank since that is only for DB2. Also, the Server ID field is not
the server’s name but tcpip.
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Figure 202. Database Options

For security reasons, make sure you set the password of the default system
administrator ID in SQL. The ID is sa.

Figure 203. Login Password

6.2.1 Setting Up the Inventory Database
After Tivoli Inventory is installed there are several post installation tasks that need
to be performed. You have to allocate the physical database and then there are a
few scripts that have to be run that create the database tables. It is easiest to use
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the database wizard to allocate the database. To get the list of wizards from the
SQL Enterprise Manager click Tools -> Wizards. To create the database click
Create Database Wizard.

Figure 204. Wizards

Figure 205. The Initial Wizard Window

Specify the same information in the database wizard that you supplied to the
Tivoli Inventory installation application.
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Figure 206. Database Details

Make sure the database is large enough to hold all of your configuration data.
See the Tivoli Inventory manuals for database sizings.

Figure 207. Database Size

You can restrict the size of the database or indicate how fast you want it to grow.

Figure 208. Database Growth Patterns
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In addition to the database, there is a transaction log file that needs to be
allocated. Provide a name for it and then specify its size.

Figure 209. Transaction Log

Figure 210. Growth Patterns for the Transaction Log File

That is all that is required from SQL to set up the initial database tables. There
are still a few scripts that have to be run from the Tivoli Inventory application.

Figure 211. Wizard Finishing
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Figure 212. Creation Completed

The isql scripts that have to be run are:

• \tivoli\bin\w32-ix86\TME\INVENTORY\SCRIPTS\RDBMS\tivoli_ms_sql_admin.sql

• \tivoli\bin\w32-ix86\TME\INVENTORY\SCRIPTS\RDBMS\tivoli_ms_sql_schema.sql

Figure 213. isql Script

There are also some query shell scripts that need to be run under the bash
interpreter:

• bash \tivoli\bin\w32-ix86\TME\INVENTORY\SCRIPTS\queries\inventory_queries.sh

• bash \tivoli\bin\w32-ix86\TME\INVENTORY\SCRIPTS\queries\subscription_queries.sh

Figure 214. Policy Region Updated with Queries

• Finally you run wfilesig -a -f swsigs.ini from the
\tivoli\bin\w32-ix86\TME\INVENTORY\SCRIPTS\signatures directory.
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Figure 215. File Signatures

If you look in the SQL database you should see the items Tivoli Inventory adds to
the inventory database and which are owned by the user tivoli. You will see the
UM Services tables after you have installed the Plus module and run the
ums_ms_sql_schema.sql script.

Figure 216. Inventory Tables

6.3 TEC

Our environment consisted of two Managed Nodes and one PC Managed Node.
We could only install the TEC Server on one system so we chose to put it on the
same system as the framework. This is not a requirement. Unless you have a
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high-end server you would probably consider separating out the framework, the
TEC Server and the database. In this case we used Microsoft SQL V7.0.

Figure 217. First Install the Server

After installing the server we added the console to the same system. We could
have installed the console in multiple places, but there was no need to in this
case.

We also installed the TEC NT Adapater and the SNMP adapter so that events
and SNMP traps would flow into TEC. The most important thing to know about
that installation is that it uses port 5529.

Figure 218. TEC Adapter Port Number on Windows NT

Once TEC was installed we had to reboot our system. It was not enough to just
shut down and restart the GUI. After the reboot we went through the same basic
installation process for TME 10 Software Distribution V3.6.
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In our environment (managed nodes and PC managed nodes) it was not really
necessary to install the Inventory and Software Distribution Gateway products.
However, since UM Services is a client-side application, we stress the importance
of endpoints when using the UM Services Plus module and even include it as an
install option on the client side for Tivoli users. In most cases we expect users to
be operating against endpoint clients which requires them to install the above
products as well as create an endpoint gateway as part of the install process.

Figure 219. Install TME 10 Software Distribution

The final piece of Tivoli software that we installed before the UM Services Plus
module was Distributed Monitoring.
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Figure 220. Distributed Monitoring

Once all the components are installed we created a TEC Console by using the
Create pull-down menu. Since the machine it was running on was called barryps2
and the user ID was root, the console was built using those values.

Figure 221. Tivoli Eesktop Interface

6.4 Preparing for UM Services Plus Module

There were three patches to the Tivoli Framework that we needed to install before
we installed the Plus module. They were downloaded from
ftp://ftp.tivoli.com/support/patches/patches_3.6/.

1. 3.6-TMF-0033
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2. 3.6-TMF-0034

3. 3.6-TMF-0038

After you uncompress the image you can install the patch just like any other Tivoli
patch. You have to install them one at a time.

Figure 222. Patches to be installed (1 of 3)

Figure 223. Patch 34 (2 of 3)
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Figure 224. Patch 38 (3 of 3)

If you upgrade to Tivoli Framework V3.6.1 you do not need these three patches
as they are incorporated into that update.

6.5 UM Services Tivoli Plus Installation

Now that the infrastructure is in place you can begin the installation process for
the UM Services Plus module. When you install the product there are two options:

1. UM ServicesPlus Module for Tivoli

2. Plus Module Support

You need to install the Plus Module Support option first. You should install both of
them on the systems that you will be providing integrated management with UM
Services and Tivoli.
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Figure 225. Tivoli Plus Support

When you click UM ServicesPlus Module for Tivoli the following window
appears:

Figure 226. Installation O ptions

We left the three default options as they were and the installation proceeded
smoothly. If you want to look at the install log go to %DB_DIR%\tmp. The files that
are of interest are:

• umsinstall.log
• UM_SERVICES_PLUS.log
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• ums_inv.log
• umsinst.log

Even before the installation was completed the icon for TivoliPlus appeared on
the TME desktop. While it was not a requirement to shutdown the desktop after
the install, we rebooted our system.

Figure 227. TivoliPlus Icon Added to the Desktop

After the plus module was installed our Tivoli environment consisted of the
following products:

Figure 228. Products Installed on our System

6.5.1 UM Services Plus Module Usage
To begin to customize the plus module double-click the TivoliPlus icon shown in
Figure 227.
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Figure 229. UM Services Plus

To see what services are available, double-click UM Services Plus for Tivoli.

Figure 230. UM Services Integration

6.5.1.1 Inventory
The first option we investigated related to the integration between the inventory
function in Tivoli and the UM Services inventory function. We double-clicked the
UM Services Inventory Queries icon. The icons in Figure 231 relate to the SQL
database table entries. In addition to using Tivoli Inventory or the icons to query
the inventory data you could also write standard SQL queries to extract the data.
The key here is the merging, in one location, of all the inventory data.

The installation of the queries is done automatically for you during the plus
module installation, but if you want to take a look at the scripts that did the
customization you can find them in the following directory:
\tivoli\bin\generic_unix\TME\PLUS\UM_SERVICES.
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Figure 231. Inventory Icons

To see what systems are subscribed to the UM Services Profile Manager you can
click the Subscribers of UM Services icon in Figure 230 on page 116. To populate
the profile managers you should add the systems that have the UM Services
client code installed. This is done by clicking the systems under the heading
Available to become Subscribers, then click the arrow that is pointing to the
left. If you click the Query button it will only find systems that are already in the
database from a previous software inventory scan.

Figure 232. UM Services Subscribers

To configure the Tivoli inventory database for UM Services inventory data for
systems that did not have the UM Services Plus module installed on them, you
have to run the ums_ms_sql_schema.sql script (or the corresponding script for
your DB2, Oracle or Sybase database). That script is automatically run for your
systems that had the initial Plus module installed on them.

To initially populate the database we selected the Managed_node barryps2 and
made it a current subscriber. Then we had to do a hardware scan followed by a
software scan. To complete your first scan double-click UM Services Inventory
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from the UM Services Plus for Tivoli window. That brings up the Profile Manager
shown in Figure 235. In addition to selecting the HW Scan you have to select the
subscribers. After you have set up the subscribers you can customize the
hardware scan. Using the right mouse key select UM Services PC HW Scan.
That brings up the following window:

Figure 233. Hardware Scan Customization

Select the ... next to the box called Script that is checked off. Click that and it
brings up the following screen:

Figure 234. UMS Drive

Go look in that script before you use it. By default, it assumes that your UM
Services agent code is stored on your C drive. If it is on another drive you will
have to modify it.
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Make sure that you select the Custom MIF file. Click Save & Close.

Then click the Profile Manager pull-down menu and then Distribute.

Since it’s only one system that you are initially performing the hardware inventory
for it should not take too long.

After you perform the hardware scan you can perform the software scan to
populate the database. This requires you to distribute that profile as well.

Figure 235. Software Scan

If you look in the SQL database you can see the inventory tables. Then you can
use the Tivoli desktop (or SQL) to look at the data.
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Figure 236. SQL UMS Inventory Tables

From the UM Services Inventory Queries window if you right mouse click any of
the icons you can look at that particular piece of inventory data. For example,
clicking Memory Details then Run Query produces the following output.

Figure 237. Query the Inventory
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If you want you can also export the data to a file on any of your systems. Just click
the Export box. You can save the information as a comma-separated file, a file
with tabs between the fields, or any character you wish (CUSTOM).

Figure 238. Export Data to a File

6.5.2 Software Distribution
You can distribute the UM Services agent using the UM Services Tivoli Plus
module. The source can either be on a CD-ROM or on a disk drive. We did our
installations from our local hard drive. Basically, as with other Tivoli software
distribution functions, you configure the file package and then install it.

The first thing you need to do is double-click Prepare for UM Services install.

Figure 239. Software Distribution Setup

That brings up a window from which you can configure the file package.
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Figure 240. Location of Code

After filling in the location where the installation image is located and the path
where you want the UM Services code to be installed click Set and Close.

Figure 241. Output from Software Distribution Preparation

Now that the package is prepared you are ready to distribute it.

6.5.2.1 Installing the Package
To install the package right-click the Install UM Services for XX (where XX= the
operating system) and select subscribers.
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Figure 242. Install UM Services Icon

Then click Set and Close, the button at the bottom of the subscribers window.
Back at the Install UM Services for NT icon, right-click it again and select
Distribute. A silent install of UM Services will occur. The default setup.iss file
looks like:

[InstallShield Silent]
Version=v3.00.000
File=Response File
[Application]
Name=UMS
Version=2.0
Company=IBM
[DlgOrder]
Dlg0=SdOptionsButtons-0
Dlg1=SdAskOptions-0
Dlg2=AskDestPath-0
Dlg3=AskSecurInfo-0
Dlg4=SdFinishReboot-0
Dlg5=MessageBox-0
Count=6
[SdOptionsButtons-0]
Result=101
[SdAskOptions-0]
Component-type=string
Component-count=4
Component-0=Basic Services
Component-1=&Web Based Access
Component-2=System Health &Monitoring
Component-3=&SNMP access and trap forwarding
Result=1
[AskDestPath-0]
szPath="C:\Program Files\IBM\UMS"
Result=1
[AskSecurInfo-0]
svUser=ums
svPassword=ums
svConfirm=ums
svPort=411
Result=1
[SdFinishReboot-0]
Result=1
BootOption=0
[MessageBox-0]
Result=1
Chapter 6. Tivoli Framework and Plus Module 123



If you want to do some customization of the package you can click Open instead
of Distribute.

Figure 243. Package Properties

Reboot your remote client and the UM Services code is installed and operational.

6.5.3 Tivoli Distributed Monitoring
As with the other Tivoli products there is integration provided for Tivoli Distributed
Monitoring and UM Services. From the UM Services Plus for Tivoli window
double-click Monitors for UM Services.

Figure 244. Distributed Monitors

The plus module provides monitors for the HTTP server processes and for the
SNMP subagent. You can use the default monitoring values or easily make
changes to them. The default polling interval shown in the following window is five
minutes. You can change that as well.
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Figure 245. Default Monitors

If you are satisfied with the defaults you can distribute them the same way you
distributed the other profiles, by right-clicking the Monitors for UM Services
icon. Just make sure the subscriber list is what you want it to be. If a threshold is
reached you might see a window like the following:

Figure 246. Threshold Alert

In addition to the alert you can also log the event, or run a command line script.
You can also provide further integration by routing the alert to the Tivoli
Enterprise Console (TEC).

To see if any of the thresholds have been reached you can also look at the UM
Services indicators icon. Double-click that followed by double-clicking the
Monitors for UM Services icon to see the list of events.

Figure 247. Indicators
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Figure 248. Monitors and Logs for SNMP

Note: Distributed monitors do not work against WIN9x endpoints. Also, using the
monitors against endpoints requires that the user add the SentryProxy managed
resource to his or her PolicyRegion.

6.5.4 Tivoli Event Console
To prepare for the TEC integration, double-click the icon Setup TEC Event
Server for UM Services. It will run a job to perform the integration. If you want to
see what the job is you can use the right mouse button.

The Plus module is configured to forward events from your distributed monitors as
well as UM Services SNMP traps for abnormal fan, temperature, voltage and
chassis intrusion environment conditions. The latter requires that the user install
the Tivoli SNMP adapter and configure it to recongize UM Services SNMP traps
and convert them to TEC events. To do this, you must open the file
tecad_snmp.cds (which comes with the SNMP adapter) and copy the contents of
UMStecad_snmp.cds to the end. In addition, you need to open the file
tecad_snmp.oid and copy the contents of UMStecad_snmp.oid to the bottom of
that file. Then you have to restart the adapter.
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Figure 249. UM Services and TEC Integration Task

Double-clicking the icon brings up the following window:

Figure 250. TEC Setup

We were using the default rule base and we preallocated the directory for the new
plus rule base. We did not specify an event console name since we only had one
and it was running on the machine we were running the TEC integration task on.
The output follows:
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Figure 251. TEC Output

Looking at the event servers rule bases we can see that in addition to the icon for
the default there is now one called plus. To activate it you have to use the right
mouse button on the current rule base. Then click Load. You can either load it
right away or have it load the next time the event server restarts.

Figure 252. Changing Rule Bases

In addition to setting up the new rule base you have to configure the event
groups. Right mouse click the Event Console and select Assign Event Groups.
The following window shows you one way to set up the event group for the
UM_Services_plus predefined event group.
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Figure 253. Assign Event Groups

If you start the event console you can see if any alerts have flowed from UM
Services to TEC.

Figure 254. Events

Once you have an event you will see an additional icon. The icon will be
dependent upon what went wrong and how severe an error it was.
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Figure 255. Critical SNMP Event from the Dstributed Monitor

Figure 255 shows integration among UM Services, Tivoli Distributing Monitors
and TEC. If you click View Message you can see some details about the
problem.
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Figure 256. Event Error Message

6.5.5 Launching the UM Services Browser
The final piece of integration we show in this chapter is the ability to launch your
UM Services browser from within the Tivoli desktop. There are other functions (for
example, rebooting a UM Services system, shutting down and waking up UM
Services) available from the UM Services Plus for Tivoli window.

UNIX users must make sure their Netscape browser is at least at V4.5, their JDK
is at a minimum of V1.1.7b, their Swing at V1.1 and their XML at V1.1.14. In
addition, make sure the enviornment variables CLASSPATH and
MOZILLA_HOME (AIX only) are set up. Those variables are case-sensitive.

There should be a separate icon for each of your UM Services systems. To
launch it double-click the icon and either press Enter or enter the host name and
port number (the default port is 411).

Figure 257. Launch UM Services Browser on Your Own System
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6.5.6 Tivoli Endpoint Configuration
UM Services clients can be configured to fit into a Tivoli Enterprise environment
by checking the Tivoli Management Agent install option and configuring a
gateway and port. Since the installation of the endpoint is silent, users do not
have an opportunity (by default) to configure a gateway and port interactively.
However, the InstallShield silent install script for the endpoint is included as part
of the UM Services install files and can be edited and changed before you begin
the installation.

[InstallShield Silent]
Version=v3.00.000
File=Response File
[Application]
Name=Lcfd
Version=4
Company=Tivoli
[DlgOrder]
Dlg0=SdWelcome-0
Count=5
Dlg1=SdComponentDialog-0
Dlg2=SdShowDlgEdit3-0
Dlg3=SdShowInfoList-0
Dlg4=SdFinish-0
[SdWelcome-0]
Result=1
[SdComponentDialog-0]
szDir=C:\Program Files\Tivoli\lcf
Component-type=string
Component-count=1
Component-0=TME 10 Endpoint
Result=1
[SdShowDlgEdit3-0]
szEdit1=9494
szEdit2=9494
szEdit3=-d1 -D login_interval=86400 -D udp_interval=300 -D udp_attempts=2
Result=1
[SdShowInfoList-0]
Result=1
[SdFinish-0]
Result=1
bOpt1=0
bOpt2=0

If you look at the block near the end there is a variable called szEdit3. Change it
to:

szEdit3=-d lcs.login_interfaces=<gatewayname?+<gatewayport>

where gatewayname? and <gatewayport> are sZedit1 and sZedit2 (9494),
respectively.
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Chapter 7. CA Unicenter Upward Integration Module

Installing the UM Services integration with Unicenter TNG Framework configures
Unicenter TNG with:

• New objects for classifying IBM hardware
• Creates a business process view for grouping IBM systems
• Modifies AimIT’s umclient.bat to automate the collection of inventory data from

UM Services systems
• Provides a batch file for creating IBM UM Services file packages that can be

distributed using the ShipIT tool
• Adds a start menu item for easy access to utilities for reclassifying already

discovered systems as IBM systems
• Adds a tool to remove and readd UM Services configuration data for those

cases when you have to rebuild your repository

After installing the CA Unicenter upward integration module for the first time, run
the reclassify utility mentioned above to reclassify systems that are already in the
repository that have UM Services installed. The new classifications are:

• IBM_NTServer
• IBM_WindowsNT
• IBM_Windows95

The upward integration module installs a Windows NT service that runs in the
background and automatically converts the classification for any future UM
Services systems discovered by Unicenter TNG.

Systems that are reclassified as IBM_NTServer, IBM_WindowsNT or
IBM_Windows95 are placed in the IBM Business Process view for easy
navigation. Right-clicking these systems provides a menu with a launch point for
UM Services.

The following are the minimum hardware requirements to install the CA Unicenter
TNG framework:

• Intel Pentium Processor (or equivalent) with 64 MB of RAM

• 200 MB of free hard disk space in one partition

• Microsoft Windows NT server installed

• Windows NT Service Pack 3 or higher installed

• A TCP/IP connection

• To use 3-D Maps, an 8 MB graphics accelerator card for optimal 3-D
performance

7.1 Installing the CA Unicenter TNG Framework

For machines that are configured to support CD-ROM autoplay, when the
CD-ROM is inserted into the drive, the Setup Wizard screen appears
automatically. If autoplay is not set up, double-click setup.exe in the Winows NT
directory on the CD-ROM.

The first screen asks you about the platform you are installing it on. We chose
Microsoft Windows NT (Intel) and clicked Next.
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Figure 258. TNG Framework Welcome

The next screen is for the setup options. Choose Install a Manager on this
Windows NT system and click Next.

Figure 259. TNG Framework Installation Option

The next screen is for the license agreement and identification. Fill in the fields
with the correct data and click Next.

To install the system, you’ll need approximately 200 MB of free space on the hard
disk. You can select on which drive the system will be installed.
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Figure 260. Selecting the Drive for Installation

After choosing the drive, you can select optional features, such as 3D Map
Components and Books On-line. If you intend to install them, just check the box
for each one.

The next screen asks about the directory locations. The wizard shows the default
locations, which can be changed by clicking the Change directory button.

Figure 261. TNG Framework Directory Location
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After choosing the directory location, a new screen will inform you that the system
is ready for installation. Click the Finish button. After copying the files, the system
will launch the services and create the folders. The services that will be started
are:

• CA-Autodiscovery

• CA-IPXDiscovery (if this protocol is installed)

• CA-Unicenter

• CA-Unicenter (NR-Server)

• CA-Unicenter (Remote)

• CA-Unicenter (Transport)

• CA-Unicenter Worldview Agent

• TNG DB Server

Figure 262. Installing the System and Launching the Services

7.1.1 Launching from a UM Services Browser
To launch the browser from the TNG Framework it is recommended to use
Internet Explorer 5.0 plus the recommended Microsoft security patches. In our
installation we used Internet Explorer 5.0.

After installing TNG framework, choose the first option on the menu: 2-D Map.
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Figure 263. Opening 2-D Map on TNG Framework

The TNG Framework will ask you to select the repository name. The repository is
the database (developed by CA as an internal file), where all the information is
stored.

Figure 264. Choosing the Repository

If it is the first time that you are launching the TNG Framework , you will have only
one repository. If not, you can choose which repository you will use by clicking the
arrow in the box.

After a few seconds, the TNG Framework will show the objects that can be
managed. Choose TCP/IP Network.
Chapter 7. CA Unicenter Upward Integration Module 137



Figure 265. Managed Objects on 2-D Map

The system will build a network map. Choose the subnet in which you are going
to work on by double-clicking the icon. In our example, we chose subnet 9. You
can also manage your own system, by clicking the icon with the system name (the
red icon). Be sure about what you want to manage, selecting only the segment to
be analyzed. If you select the whole network, it will generate a lot of traffic on your
subnets.
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Figure 266. TCP/IP Network Map

Opening the subnet gets you more details about the servers and their segments.
For our example, we chose the segment 9.24.106.0.

Figure 267. The Segment Details
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To view all the computers in the segment, double-click the Segment Viewer.

Figure 268. Options Visible by Clicking the Left Mouse Button

By clicking with the left mouse button on any machine, a yellow box will appear
with the name and the IP configuration.

By clicking the right button you get a pop-up menu. This menu allows you to ping
the machine, open a Telnet session, view the machine details, and more. But, it
will not allow you to launch the UM Services browser yet. To do that, you have to
configure the machine as an IBM machine.
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Figure 269. Options Visible by Clicking the Rght Mouse Button

To launch the UM Services browser you need to indicate to the TNG Framework
that the machine selected is an IBM machine.

Note: This is done after you have installed the UM Services code on the TNG
system.

To change the specification for a system to be an IBM UM Services-managed
machine, click with the right button the machine you want to launch and choose
Reclassify Object. A window called Class Transfer Dialog will be opened and
you have to scroll down through the screen until you reach the object class
Workstation.
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Figure 270. The Class Transfer Dialog

When you open the Workstation class (clicking the + sign), a list with subclasses
appears. You can choose between the IBM_Windows95 or IBM_WindowsNT
classes. Click your choice and then click OK. Another screen will be opened. This
screen looks like a notebook and has information about that system. Just click
OK again to confirm after you update the fields.
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Figure 271. Reclassifying a Class

After clicking OK, a confirmation message appears and the icon for that system
changes to an IBM icon.

Figure 272. Message Indicating the SuccessfulReclassification

Now, if you click the system with the right button, the pop-up menu will show one
more option : UMS.
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Figure 273. The New Option UM Services on the Pop-Up Menu

It’s very important to know that this option will be available only for IBM systems.
After clicking the UMS option, the system will launch your browser with all of the
UM Services functions.
144 Universal Manageability: Enterprise Management Integration



Figure 274. Browser with UM Services

7.1.2 Inventory
The inventory on a CA environment will depend on the system configuration:

1. If you have CA Unicenter TNG installed, the Asset Management Option (AMO)
is the core of desktop management, including inventory.

2. If you have Unicenter Framework installed, you need the CA AimIT product,
which is a tool used to gather inventory information.

For both of them CA provides a batch file (UMClient.BAT) which runs every time a
system logs on a server (through the login script). This batch file is responsible
for gathering and updating all the hardware and software information about each
machine.

The integration of the CA Unicenter with UM Services is done by using this batch
file. UM Services modifies this file in order to run a Java Program, which
generates the MIF files and stores them into the client machine. When CA
Unicenter TNG (through AMO) or Framework (through CA AimIT) needs the
information about IBM systems, they can reach them and update the database.

If you already have AMO or AimIT installed, then the umclient.bat modifications
are done automatically at installation time. Otherwise, you have to do it manually.
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Figure 275. The UMClient.BAT File

After installing the UM Services, the first lines of the UMClient.BAT are changed.
UM Services adds some lines in order to call the Java program. These lines can
be seen in the square in Figure 275.

Figure 276. MIF and MNV File Generation
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Figure 277. The Location of the bat File in the AimIT Folder on the Server

The file UMclient.bat is launched every time the machine logs on to the network
and it updates all the hardware and software information. A screen informing you
that the data is being collected is shown.

Note: The UM Services version we tested didn’t allow us to gather information
without logging on to the network.

Figure 278. Collecting the Inventory Information

After collecting the data, a MIF file is generated and stored on the client machine
with a .MIF extension. When CA needs to update its database, it get this
information and converts it automatically into a .MNV extension. The MNV format
is CA’s standard.
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Figure 279. MIF File Localization on the Client System

The MIF and the MNV files have the same information but in different formats.
The MIF file is generated by a Java program installed by UM Services. The MNV
file has the same information as the MIF, but in CAs format.

Figure 280. Example of a MIF File Format
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Figure 281. Example of a MNV File Format

There are two different ways to use the UM Services inventory in CA Framework.
The first is using the Admin Console on the AimIT menu.

Figure 282. Accessing the Admin Console on AimIT Menu

Click the Admin Console option to get the user validation screen.
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Figure 283. Validation Screen on AimIt Admin Console

After logging in, the next screen will be the main screen for AimIT. It shows the
entire domain and its machines.

Figure 284. The AimIt Main Screen

After selecting a machine, click the Inventory option.
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Figure 285. Options on Inventory

The inventory option will show the main characteristics of each component in the
selected computer. Clicking the Inventory Browser opens up a window with
detailed information.

Figure 286. Detailed Options on Inventory Browser
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Open the detailed window. In the left-hand paneof the window you can see the
components; on the right-hand pane you can see the status. At the bottom of the
left pane, there is a button called Additional. By clicking this button other
information can be accessed; for example, the UMS option with all the information
about the IBM machine. This information will be displayed in the AimIT standard -
the topic in the left pane and the detailed information in the right pane.

Figure 287. UM Services Inventory Showing the Port Connectors

There is another way to get the UM Services option. By using the 2D-Map option
(from TNG Framework TNG), you can see an icon called AimIT Network.
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Figure 288. The AimIT Network Icon

Of course, the AimIT Network icon will just be available when the AimIT is
installed on the TNG Framework machine.

Access the AimIT Network by double-clicking the icon in Figure 288. A new menu
will appear, such as the menu on the AimIT Admin Console.
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Figure 289. Accessing the Inventory Using 2-D Map

On the domain you can see the icon domain:computer. Accessing this icon, the
2-D Map will show all the computers configured on that domain.

Figure 290. The Computers in the Domain

By clicking one of the objects you will receive the same options that you had on
the AimIT Admin Console, including the inventory.
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Figure 291. Accessing the Inventory on 2-D Map

Accessing the inventory, you will have the same options as shown in Figure 286.

7.1.3 Software Distribution
To distribute software, another CA module called ShipIT is used. It has a simple
interface, using libraries and the drag and drop concept to launch the distribution.

Figure 292. ShipIT Main Screen
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To add the UM Services library, we had to copy all of UM Services content to the
folder \TNGFW\ibm\sw_distribution. In this folder, there were two files:
procedure.bat and rr_swdistrib.bat.

In fact, the file rr_swdistrib.bat calls the procedure.bat. These two files were
installed when the UM Services UIM was installed.

Note: Actually, all the files needed should be copied automatically during the UM
Services installation. The next UM Services releases will do that. For our tests,
we had to copy them manually.

Figure 293. Software Dstribution Folder with The bat Files

Figure 294. The rr_swdistrib.bat File

The file rr_swdistrib.bat uses CA commands to include a new path and calls the
file procedure.bat.
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Figure 295. The procedure.bat File

After running procedure.bat (after closing ShipIT and using an MS-DOS window),
it creates the Library UM Services agent install. This library must be used to
perform the distribution of UM Services software. To distribute other software,
new libraries must be created.

Figure 296. Running the rr_swdistrib.bat File

To start software distribution, run the SD Explorer on the ShipIT menu and you
will see the UM Services library created by the batch files.

Figure 297. Running Software Distribution Explorer on ShipIT

After the login screen, the system will show the main screen of the software
distribution Explorer.
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Figure 298. The Software Distribution Explorer with the UM Services Library

There are three main options:

1. Computers - Will show all the computers that can receive any installation.

2. Software Library - The libraries where the programs to install are stored.

3. Jobs - Shows the installation progress or schedule.

To install an application, just drag this application and drop in the computer
selected. You can also configure groups and schedule the installation.

Figure 299. Job Status during an Installation
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To create a new library, you may have to use the ShipIT menus.

Figure 300. Adding a Software Library

The creation of an unattended installation library requires you to write a script
with all the steps to install the software, including answers such as yes, no and
path.

After it is created, this library can be stored and launched as you need it.

Figure 301. Creating a New Library
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Figure 302. Steps for Library Creation

7.1.4 Alerts and SNMP
The Unicenter TNG upward integration module configures the Unicenter TNG
Event Manager with message records and actions customized to UM Services
SNMP traps. When the Unicenter server receives a UM Services SNMP trap of
severity level that is critical, by default it displays a banner showing a description
of the trap.

UM Services installs two SNMP V1 MIB files that can be viewed with Unicenter
TNG’s Object View tool. The names of the MIB files are ums.mib and
umsagent.mib.
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Chapter 8. Intel LANDesk Upward Integration Module

UM Services provides some integration into the Intel LANDesk Management
Suite. In this chapter we show you how to set up your environment for the
integration. We also show you how the integration works from an inventory
perspective. We do not go into a lot of detail on how to customize Intel LANDesk.
Also, we chose to use the default Microsoft Access database instead of SQL
V7.0.

8.1 Installing Intel LANDesk V6.2

You can install the suite directly from the CD-ROM or a LAN image of it. You just
need to have a license key ready. For the integration with UM Services you need
to install the Intel LANDesk Desktop Manager component.

Figure 303. Desktop Manager

As with most product installation on Windows NT you are advised to close other
applications to prevent any problems during the installation. You should be logged
in as a user with administrator privileges. In this case we were running Windows
NT Server Enterprise Edition V4.0 with Service Pack 4 installed.

You might want to list your environment variables and your services before the
install so you can see what changes on your system. In some cases, you might
have security issues for some tasks and who can start or stop them.
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Figure 304. Initial Welcome Message

Click Next and you get a prompt for the license. After acknowledging that window
you choose the LANDesk features that you need. For purposes of integration we
installed only the Core Server and the Management Console.

Figure 305. Components to Be Installed

The next part of the install is related to the database. There is an option to use
the default built-in database or another database like SQL V7.0. We chose to use
the default database in this case since we didn’t have a lot of data to store.
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Figure 306. Microsoft Access of SQL V7.0

You need to provide a user ID to which the service can log on to. We used our
administrator user ID.

Figure 307. Data Source Information

After the database access was set up the rest of the code was copied to our
system and Intel LANDesk Desktop Manager was installed. You still need to set
up the client interface. You need to execute ipsetup.bat.
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Figure 308. ipsetup.bat Creates the Client Directory

That creates a directory on your C: drive called \LANCLIENT. You then need to
reboot your system.

Running ipsetup.bat will make generically discovered systems an LDMS client. It
will push down the Common Base Agent (CBA). This makes it unnecessary for
the user to choose the LANDesk Management Suite Integration option during the
install of UM Services (which would also install the CBA). If you try to install it
twice it will cause problems.

You get ldinv.bat and the inventory scanner with the UM Services installation.
They are not contingent upon checking the LDMS integration box during the
installation of UM Services. Some customization of ldinv.bat is still required and
you should add it to your startup if you want to automate the generation of UM
Services-specific MIF files.

Figure 309. Reboot after the Desktop Manager and the Client Code Are Installed

Upon rebooting you should look in your Startup folder. There should be two new
icons placed there. One of them is called Custom Data Forms and the other is
called Inventory Scan.
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Figure 310. LANDesk Startup Tasks

You need to remove the Inventory Scan icon from the startup. You are going to
replace that with a batch file that comes with the UM Services installation later
on.

Figure 311. Remove the Inventory Scan

You are now ready to install UM Services and its integration code for Intel
LANDesk.

8.1.1 UM Services Installation for Intel LANDesk
As with all product installations you should stop all other tasks that you can on the
system and you should also have a backup of the registry and the system. We did
not have any problems with the installation process and did not need to restore
anything.

New startup
procedure from
UM Services
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Figure 312. UM Services Welcome

The integration of UM Services and Intel LANDesk is different from the other
integration components. For all of the others in this redbook you need to click the
Workgroup/Enterprise Integration button. For LANDesk you need to click the top
button, Universal Manageability Services.

Figure 313. UM Services Plus Intel LANDesk

By default the LANDesk component is not checked. We clicked the check box
LANDesk(TM) Management Suite Integration.
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Figure 314. Integrated Install

You need to decide in which directory the code gets installed. We used the default
installation directory. On our system, Windows NT was installed on the D: drive so
that’s where UM Services points to by default.

Figure 315. Install Directory

Enter the user ID and password for an ID that has administrator privileges.
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Figure 316. Administrator ID

Click Yes so that updates can be made to your start menu for UM Services.

Figure 317. Start Menu Modifications

If you run the inventory scanner automatically or the ldinv.bat file that comes with
the UM Services integration you should see a pop-up window similar to the
following:
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Figure 318. Gathering Inventory

All of the MIF files are updated or created in \dmi\dos\mifs. An example of one of
them follows:

Start Component
Name = "UM Services Inventory"

Start Group
Name = "DMI"
Class = "IBM-PCCo|UMA MIF DMI|001"
Key = 1
Start Attribute

Name = "Index"
Id = 1
Type = Integer
Access = Read-Only
Storage = Common
Value = 1

End Attribute

Start Attribute
Name = "Version"
Id = 2
Type = String(64)
Access = Read-Only
Storage = Common
Value = "Intel DMI Service Provider (Win32) V2.54"

End Attribute

Start Attribute
Name = "Product"
Id = 3
Type = String(64)
Access = Read-Only
Storage = Common
Value = "Win32 DMI Service Provider"

End Attribute

Start Attribute
Name = "Win32 DMI Directory"
Id = 4
Type = String(18)
Access = Read-Only
Storage = Common
Value = "C:\\DMI\\Win32\\MIFDB"

End Attribute
End Group

Start Table
Name = "DMI"
Class = "IBM-PCCo|UMA MIF DMI|001"
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Id = 2
{ 1, "Intel DMI Service Provider (Win32) V2.54", "Win32 DMI Service Provider",

"C:\\DMI\\Win32\\MIFDB" }
End Table

End Component

You need to make a modification to the ldinv.bat file before you can use it. You
need to remove a rem statement (which makes it a comment card), and you also
need to make sure you are pointing to the right hard drive. By default, the system
assumes that you have installed the code and Windows NT on the C: drive.

Figure 319. Inventory Scanner Batch Update

After you have run the inventory scanner routine you can access UM Services
using either MMC or a Web browser. In this case we chose to use a Web browser.

REM
removed Replacement values
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Figure 320. Accessing UM Services Data Using a Web Browser

In addition to bringing up the UM Services interface we brought up the Intel
LANDesk Desktop Manager to show the inventory integration. There is much
inventory-related data that LANDesk captures. The following two figures show
some of it:

Figure 321. Desktop Manager (Part 1 of 2)

The MIF data contains the integrated UM Services inventory information.
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Figure 322. Desktop Manager (Part 2 of 2)

Figure 323 shows you the discovery process for Intel LANDesk agents:

Figure 323. Discover Intel LANDesk Agents

Figure 324 shows the integrated MIF/UM Services inventory information.
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Figure 324. Integrated UM Services Inventory Information

8.1.2 Monitor the Inventory
One interesting task to try is to pick a field in the inventory and monitor it so that if
the data changes an event can be created. For simplicity we picked the user data
field. The following setup would be true for any of the inventory data fields.
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Figure 325. User Data

If we right mouse click any of the attribute fields in the left-hand pane you get a
pull-down menu. Select Properties.

Figure 326. Data Property Characteristics

After you click Notify event log on change you should try to change the field and
rerun the inventory scan. You could also use the Desktop Manager interface to
turn on many different attribute bytes on a single screen.
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Figure 327. Alert Settings

Figure 328. Help for Inventory Alerts

There are other types of alerts that you can set up with Intel LANDesk Manager.
The following section shows you the settings.

8.1.2.1 Alert Settings in LANDesk Manager
From the main Desktop Manager interface click View -> Alerts -> Settings.
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Figure 329. Alert Settings

Using the right mouse to click the Intel Inventory Scanner then click Configure.

Figure 330. Configure the Alert

You are presented with a window that lets you set up the action to take. We chose
to write to the event log when the scanner was run.
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Figure 331. Write to the Event Log

Click Next after you select your option.

Figure 332. Discovered Systems

After you select your system click Next.
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Figure 333. Default Settings Updated

Now that all your alerts are configured you can change your original data in the
UM Services Asset ID window to generate an event. You could just have easily
turned the monitor on for the amount of memory in a system.

Figure 334. Asset ID User Data

After you change any field and click Apply rerun the inventory scan.
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Figure 335. Rerun Inventory Scan

If you look in the Windows NT Event Viewer you should see several events.

Figure 336. Events as a Result of Changing the Data Felds

Figure 337 shows the event detail for each of the events. It indicates the original
value in each field and the new value:

Figure 337. Event Details

You could also go back to the property values and select the Value tab to see a
history of changes for that field.
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Figure 338. Property Values
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Appendix A. Special Notices

This publication is intended to help systems management professionals
implement UM Services in their existing environment. The information in this
publication is not intended as the specification of any programming interfaces that
are provided by UM Services. See the PUBLICATIONS section of the IBM
Programming Announcement for UM Services for more information about what
publications are considered to be product documentation.

References in this publication to IBM products, programs or services do not imply
that IBM intends to make these available in all countries in which IBM operates.
Any reference to an IBM product, program, or service is not intended to state or
imply that only IBM's product, program, or service may be used. Any functionally
equivalent program that does not infringe any of IBM's intellectual property rights
may be used instead of the IBM product, program or service.

Information in this book was developed in conjunction with use of the equipment
specified, and is limited in application to those specific hardware and software
products and levels.

IBM may have patents or pending patent applications covering subject matter in
this document. The furnishing of this document does not give you any license to
these patents. You can send license inquiries, in writing, to the IBM Director of
Licensing, IBM Corporation, North Castle Drive, Armonk, NY 10504-1785.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact IBM Corporation, Dept.
600A, Mail Drop 1329, Somers, NY 10589 USA.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The information contained in this document has not been submitted to any formal
IBM test and is distributed AS IS. The information about non-IBM ("vendor")
products in this manual has been supplied by the vendor and IBM assumes no
responsibility for its accuracy or completeness. The use of this information or the
implementation of any of these techniques is a customer responsibility and
depends on the customer's ability to evaluate and integrate them into the
customer's operational environment. While each item may have been reviewed by
IBM for accuracy in a specific situation, there is no guarantee that the same or
similar results will be obtained elsewhere. Customers attempting to adapt these
techniques to their own environments do so at their own risk.

Any pointers in this publication to external Web sites are provided for
convenience only and do not in any manner serve as an endorsement of these
Web sites.

Any performance data contained in this document was determined in a controlled
environment, and therefore, the results that may be obtained in other operating
environments may vary significantly. Users of this document should verify the
applicable data for their specific environment.
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Reference to PTF numbers that have not been released through the normal
distribution process does not imply general availability. The purpose of including
these reference numbers is to alert IBM customers to specific information relative
to the implementation of the PTF when it becomes available to each customer
according to the normal IBM PTF distribution process.

The following terms are trademarks of the International Business Machines
Corporation in the United States and/or other countries:

The following terms are trademarks of other companies:

Tivoli, Manage. Anything. Anywhere.,The Power To Manage., Anything.
Anywhere.,TME, NetView, Cross-Site, Tivoli Ready, Tivoli Certified, Planet Tivoli,
and Tivoli Enterprise are trademarks or registered trademarks of Tivoli Systems
Inc., an IBM company, in the United States, other countries, or both. In Denmark,
Tivoli is a trademark licensed from Kjøbenhavns Sommer - Tivoli A/S.

C-bus is a trademark of Corollary, Inc. in the United States and/or other countries.

Java and all Java-based trademarks and logos are trademarks or registered
trademarks of Sun Microsystems, Inc. in the United States and/or other countries.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States and/or other countries.

PC Direct is a trademark of Ziff Communications Company in the United States
and/or other countries and is used by IBM Corporation under license.

ActionMedia, LANDesk, MMX, Pentium and ProShare are trademarks of Intel
Corporation in the United States and/or other countries.

UNIX is a registered trademark in the United States and other countries licensed
exclusively through The Open Group.

SET and the SET logo are trademarks owned by SET Secure Electronic
Transaction LLC.

Other company, product, and service names may be trademarks or service marks
of others.

AIX Alert on LAN
AS/400 Asset ID
DB2 IBM
Netfinity NetView
PC 300 RS/6000
SP System/390
ThinkPad WebSphere
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Appendix B. Related Publications

The publications listed in this section are considered particularly suitable for a
more detailed discussion of the topics covered in this redbook.

B.1 IBM Redbooks Publications

For information on ordering these publications see “How to Get IBM Redbooks”
on page 185.

• Universal Management Agent: Functions and Integration, SG24-5294

• Integrating LAN Management Tools with Tivoli LAN Access, SG24-2118

B.2 IBM Redbooks Collections

Redbooks are also available on the following CD-ROMs. Click the CD-ROMs
button at http://www.redbooks.ibm.com/ for information about all the CD-ROMs
offered, updates and formats.

B.3 Referenced Web Sites

These Web sites are also relevant as further information sources:

• http://www.redbooks.ibm.com

• http://w3.itso.ibm.com

• http://inews.ibm.com

• http://www.elink.ibmlink.ibm.com/pbl/pbl

• http://www.pc.ibm.com/ww/solutions/enterprise/sysmgmt/products.html/ UM
Services installation code

• ftp://ftp.tivoli.com/support/patches/patches_3.6/ Tivoli Framework
patches

CD-ROM Title Collection Kit
Number

System/390 Redbooks Collection SK2T-2177
Networking and Systems Management Redbooks Collection SK2T-6022
Transaction Processing and Data Management Redbooks Collection SK2T-8038
Lotus Redbooks Collection SK2T-8039
Tivoli Redbooks Collection SK2T-8044
AS/400 Redbooks Collection SK2T-2849
Netfinity Hardware and Software Redbooks Collection SK2T-8046
RS/6000 Redbooks Collection (BkMgr Format) SK2T-8040
RS/6000 Redbooks Collection (PDF Format) SK2T-8043
Application Development Redbooks Collection SK2T-8037
IBM Enterprise Storage and Systems Management Solutions SK3T-3694
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How to Get IBM Redbooks

This section explains how both customers and IBM employees can find out about ITSO redbooks, redpieces, and
CD-ROMs. A form for ordering books and CD-ROMs by fax or e-mail is also provided.

• Redbooks Web Site http://www.redbooks.ibm.com/

Search for, view, download or order hardcopy/CD-ROM redbooks from the redbooks web site. Also read
redpieces and download additional materials (code samples or diskette/CD-ROM images) from this redbooks site.

Redpieces are redbooks in progress; not all redbooks become redpieces and sometimes just a few chapters will
be published this way. The intent is to get the information out much quicker than the formal publishing process
allows.

• E-mail Orders

Send orders via e-mail including information from the redbooks fax order form to:

• Telephone Orders

• Fax Orders

This information was current at the time of publication, but is continually subject to change. The latest information for
customer may be found at http://www.redbooks.ibm.com/ and for IBM employees at http://w3.itso.ibm.com/.

In United States
Outside North America

e-mail address
usib6fpl@ibmmail.com
Contact information is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl/

United States (toll free)
Canada (toll free)
Outside North America

1-800-879-2755
1-800-IBM-4YOU
Country coordinator phone number is in the “How to Order” section at
this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl/

United States (toll free)
Canada
Outside North America

1-800-445-9269
1-403-267-4455
Fax phone number is in the “How to Order” section at this site:
http://www.elink.ibmlink.ibm.com/pbl/pbl/

IBM employees may register for information on workshops, residencies, and redbooks by accessing the IBM
Intranet Web site at http://w3.itso.ibm.com/ and clicking the ITSO Mailing List button. Look in the Materials
repository for workshops, presentations, papers, and Web pages developed and written by the ITSO technical
professionals; click the Additional Materials button. Employees may also view redbook. residency, and workshop
announcements at http://inews.ibm.com/.

IBM Intranet for Employees
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IBM Redbooks Fax Order Form
Please send me the following:

We accept American Express, Diners, Eurocard, Master Card, and Visa. Payment by credit card not
available in all countries. Signature mandatory for credit card payment.

Title Order Number Quantity

First name Last name

Company

Address

City Postal code

Telephone number Telefax number VAT number

Invoice to customer number

Country

Credit card number

Credit card expiration date SignatureCard issued to
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